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Guide to Using the Monitor III Program

1. Connect the hardware. See TT-1405 for instructions.

� Install KBUS/Modbus converter modules into Series 340 controllers and power monitors.

� Connect as many as 247 devices in an RS-485 network.

2. Configure the devices. See TT-1405 and the controller Operation/Installation Manual for instructions.

� Assign a unique network address to each device.

� Set the baud rate on each device. The baud rates must be the same on all connected devices and the PC.

3. Install the program.

� Use the PC’s Add/Remove programs utility or click on the setup.exe file on the Monitor III CD-ROM.

� Plug the hardware key into the PC’s USB port.

4. Start the program. From the Start menu, select Programs→DDC MTU→Monitor III.

5. Log in.

� Enter the username and password at the login screen. There are three levels of access:

User Name: SUPERVISOR, Password: spw (highest access)

User Name: USER, Password: upw (limited access)

User Name: GUEST, Password: [blank] (monitoring only).

� Change the username and password to prevent unauthorized access.

Note: User names and passwords are case-sensitive.

6. Set up the site(s).

� From the menu toolbar at the top of the screen, select File→Manage Sites.

� Click on New to set up one or more device sites:

� Type a name for the site into the Site Name box.

� Select the communications parameters in the Monitoring Mode window.

� Click on Add Device and enter the network address and unique description for each device at the site.

� Click on OK when the site setup is complete.

� Click on Done when all sites have been set up.

7. Connect to a site.

� Select Connection→Connect to display the list of sites.

� Click on one site to select it, and then click on Connect.

Note: Only one site can be connected at a time.

8. Create data windows to display device system information and settings.

� Double click on one of the devices listed in the Site Overview window. The Add Window screen for the

selected switch appears on the screen.

� To create data windows when the Site Overview window is closed, selectWindow→NewWindow from the

menu toolbar at the top of the screen and then click on the desired device from the list on the left.

� Drag and drop windows or use Window→Cascade Windows to arrange the windows on the screen, if

desired.

9. Change settings on Digital 550 generator set controllers, DXPower� 1000 transfer switch9. Change settings on Digital 550 generator set controllers, DXPower 1000 transfer switch
controllers or DXPower 1500� transfer switch controllers if necessarycontrollers, or DXPower 1500� transfer switch controllers if necessary.

D bl li k th l t d di l i d l tWi d S t f th M t lb t th t f� Double-click on the selected display window or selectWindow→Setup from the Menu toolbar at the top ofp y p p

the screen. The setup window will appear.the screen. The setup window will appear.

Note: Some display windows are for monitoring only and do not have a corresponding setup window.

10. Save screens and settings for future use, if desired.

11. Disconnect.

� Choose Connection→Disconnect to disconnect the PC from the controller.

12. Exit the program.

� Choose File→Exit to exit and close the Monitor III Program.

Refer to the Table of Contents for more detailed information for each step.
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Safety Precautions and Instructions

IMPORTANT SAFETY INSTRUCTIONS.

Electromechanical equipment,
including generator sets, transfer
switches,switchgear, andaccessories,

can cause bodily harm and pose
life-threatening danger when
improperly installed, operated, or
maintained. To prevent accidents be
aware of potential dangers and act
safely. Read and follow all safety

precautions and instructions. SAVE
THESE INSTRUCTIONS.

Thismanual hasseveral typesofsafety
precautions and instructions: Danger,
Warning, Caution, and Notice.

DANGER

Danger indicates the presence of a
hazard that will cause severe

personal injury,death, orsubstantial
property damage.

WARNING

Warning indicates the presence of a
hazard that can cause severe

personal injury,death,orsubstantial
property damage.

CAUTION

Caution indicates the presence of a
hazard that will or can cause minor

personal injury or property damage.

NOTICE

Notice communicates installation,
operation, or maintenance information
that is safety related but not hazard
related.

Safety decals affixed to the equipment

in prominent places alert the operator
or service technician to potential
hazards and explain how to act safely.
The decals are shown throughout this
publication to improve operator
recognition. Replace missing or

damaged decals.

Accidental Starting

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set.
Accidental starting can cause
severe injury or death. Before
working on the generator set or
connected equipment, disable the

generator set as follows: (1) Move the
generator set master switch to theOFF
position. (2) Disconnect the power to
the battery charger. (3) Remove the
battery cables, negative (--) lead first.
Reconnect the negative (--) lead last

when reconnecting the battery. Follow
these precautions to prevent starting of
the generator set by an automatic
transfer switch, remote start/stop
switch, or engine start command froma
remote computer.

Hazardous Voltage/
Electrical Shock

Hazardous voltage.
Will cause severe injury or death.

Disconnect all power sources before
opening the enclosure.

DANGER

Servicing the transfer switch.
Hazardous voltage can cause
severe injuryordeath. Deenergizeall
power sources before servicing. Open

the main circuit breakers of all transfer
switch power sources and disable all
generator sets as follows: (1) Move all
generator set master controller
switches to the OFF position. (2)
Disconnect power to all battery

chargers. (3) Disconnect all battery
cables, negative (--) leads first.
Reconnectnegative (--) leads lastwhen
reconnecting the battery cables after
servicing. Follow these precautions to
prevent the starting of generator sets

byanautomatic transfer switch, remote
start/stop switch, or engine start
command from a remote computer.
Before servicing any components
inside the enclosure: (1) Remove all
jewelry. (2) Stand on a dry, approved

electrically insulated mat. (3) Test
circuits with a voltmeter to verify that
they are deenergized.

Opening the power monitor
enclosure. Hazardous voltage can

cause severe injury or death. A
transfer switch or generator set
connected to the power monitor could
automatically energize the power
monitor or accessories. Disconnect all
power sources before opening the

enclosure. Move the generator set
master switch on the controller to the
OFF position and disconnect the
battery negative (--) lead before
proceeding.
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Introduction

This manual covers the installation and operation of the

Monitor III Program for personal computers running the

Windows� operating system. The Monitor III program

allows remote monitoring and control of transfer

switches and generator sets equipped with the following

controllers:

� Digital 550 generator set controller

� Digital generator set controller

� Microprocessor-Plus, 16-Light generator set

controller

� DXPower� 1500 programmable transfer switch

controller

� DXPower� 1000 programmable transfer switch

controller

� MATS automatic transfer switch controllers

� MATS+ automatic transfer switch controllers

� Digital Power Monitor

Information in this publication represents data available

at the time of print. The manufacturer of DDC/MTU

PowerGeneration products reserves the right to change

this literature and the products represented without

notice and without any obligation or liability whatsoever.

Read this manual and carefully follow all procedures

and safety precautions to ensure proper equipment

operation and to avoid bodily injury. Read and follow the

Safety Precautions and Instructions section at the

beginning of this manual. Keep this manual with the

equipment for future reference.

List of Related Literature

Before using the software, the connect the controller to

the PC or device network and configure it for

communication. Connection diagrams, hardware

requirements, and controller setup parameters are

covered in a separate publication, TT-1405, which is

included with the Monitor III software kit. Controller

setup instructions are covered in the controller

Operation Manual.

Obtain the controller Operation manual(s) and

Instruction Sheet TT-1405 before beginning. The

related document part numbers follow.

Operation Manual for Model:

Part

Number

Digital 550 Generator Set Controller
Operation Manual:

Version 2.10 and higher

Versions prior to 2.10

MP-6200

MP-6083

Digital 550 Generator Set Controller Setup
and Application

MP-6140

Digital Generator Set Controller MP-5829

Microprocessor-Plus Generator Set
Controller

MP-6161

Automatic Transfer Switches with DXPower� 1500
Controls:

Model SCS, SCP MP-6446

Model SSS, SSP MP-6447

Model SBS, SBP Bypass/Isolation MP-6448

Model SGS, SGP Bypass/Isolation MP-6449

Automatic Transfer Switches with DXPower� 1000
Controls:

Model SCT, SCP MP-6126

Model SBT, SBP Bypass/Isolation MP-6128

Model SDT, SDP MP-6225

DXPower� 1500 MP-6135

MATS+ Transfer Switch Controller MP-5664

Digital Power Monitor MP-5875

Connection and Converter Kits for
Monitor III TT--1405

Communication Module for the
Microprocessor-Plus Generator Set
Controller

TT--1377

Product Identification Information

Software Version Number

Record the software version number. The version

number is shown on the CD-ROM, on the software

Welcome screen, and under Help→About.

Software Version Number

Windows� is a registered trademark of Microsoft Corporation.
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Service Assistance

For professional advice on generator power

requirements and conscientious service, please contact

your nearest DDC/MTU Power Generation distributor.

� Consult the Yellow Pages under the heading

Generators—Electric

� Visit the DDC/MTU Power Generation website at

ddcmtupowergeneration.com

� Look at the labels and stickers on your DDC/MTU

Power Generation product or review the appropriate

literature or documents included with the product
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Section 1 Requirements and Software Installation

1.1 Introduction

TheMonitor III program allowsmonitoring and control of

generator set controllers, transfer switch controllers,

and power monitors using a personal computer (PC)

with theWindows� operating systemand user interface.

Refer to the controller operationmanual for descriptions

of the data and messages communicated by the

controller. See the List of Related Literature in the

Introduction for the document part numbers.

Monitor III communicates using standard Modbus�

protocol. The software allows communication through

local direct connections, remotemodemconnections, or

a TCP/IP network. See TT-1405 for more information.

1.2 Requirements

1.2.1 System Requirements

Theminimum system requirements to run theMonitor III

Program are:

� 133 MHz or higher Intel� Pentium�-compatible CPU

� 32 MB RAM

� CD-ROM drive and 75MB hard drive space available

for installation

� 800 x 600 or better color monitor (1024 x 768

recommended)

� Windows� 2000 or Windows XP� operating system

with Internet Explorer version 4.0 or higher

� COM port numbered between 1 and 255, capable of

baud rates of 9600 or 19200

� Network interface card (for applications using

ethernet connections)

� Adobe� Reader� or Acrobat� to display the Help

information

1.2.2 Hardware Requirements

The following system hardware items are required for

device connection and communication. See TT--1405

for details.

Note: For the DXPower 1500 transfer switch controller,

see the ATS Operation and Installation Manual

for connection and communication setup

instructions.

� Hardware key (also called a dongle; included with the

software kit, see Section 1.2.3)

� RS-232 to RS-485 converter (included with software

kit)

� Shielded #12-24 AWG twisted pair cable, Belden

#9841 or equivalent, for the RS-485 connections

(customer-provided)

� PC modem and device modem if remote modem

connections are used (kits that include the device

modem and the necessary cables, adapters, and

converters are available from the factory)

� If Ethernet connections are used, one

Modbus�/Ethernet converter for each site or device.

A Modbus�/Ethernet converter is not required for the

DXPower 1500 transfer switch controller.

Note: Monitor III can communicate with only one

Modbus�/Ethernet converter at a time. See

TT--1405 for connection types.

� USB-to-serial converter only if your PC has a USB

port rather than a serial port (customer-provided; the

Belkin USB Serial Adapter is one example)

� The following controllers must be equipped with

Modbus�/KBUS converter modules:

� Digital generator set controller

� MATS automatic transfer switch controllers

� MATS+ automatic transfer switch controllers

� Digital Power Monitor

� The Microprocessor-Plus 16-Light generator set

controller must have the red main logic board

(November 2003 or later), and be equipped with the

communication board GM32644-KA1 or -KP1.

Windows�, Windows NT�, and Windows XP� are registered trademarks of Microsoft Corporation.

Pentium� is a registered trademark of Intel Corporation.

Adobe�, Acrobat�, and Reader� are registered trademarks of Adobe Systems Incorporated.
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1.2.3 Hardware Keys

A hardware key (dongle) is required in order to run the

program on your PC. One key is included with each

software kit. See Figure 1-1.

Note: Only the hardware keys supplied with Monitor III

or Surveyor software kits will allow the program to

run. Keys purchased elsewhere for other

applications will not work.

Insert the key into the PC’s USB port before attempting

to run the program. Figure 1-2 shows typical USB port

locations. A red LED on the key indicates that the key is

activated.

See Section 2.13.2 if you see an “Invalid hardware key”

message at program startup.

tt1349

Figure 1-1 Hardware Key (dongle)

1. Serial (RS-232) port

2. Parallel (printer) port
3. USB ports

tt1349

1

2

3

Serial Port:

USB Port:

Typical
Port Labels:

Figure 1-2 Typical Computer Ports

1.3 Hardware Connections

Refer to TT-1405, Converter Kits and Connections,

provided with the software kit, for connection diagrams

and instructions to connect the PC and monitored

devices.

For the DXPower 1500 transfer switch controller, see

the ATS Operation and Installation Manual for

connection and communication setup instructions.

1.4 Software Installation and

Removal

For simplicity, this manual and the software assumes

that the PC has the CD-ROM drive installed as the D:

drive and the hard drive installed as the C: drive. If your

drive locations are different, type in the correct drive

letter for your PC hard drive or CD-ROM drive when

applicable during software installation or operation.

Note: When updating the Monitor III software to a new

version, remove the old version of the software

first. See Section 1.4.2, Software Removal.

Then install the complete new version.

1.4.1 Installation

The Monitor III software CD-ROM contains various files

that are used by the setup program to install the software

on the PC. The setup program automatically installs a

shortcut to run the program from the Start menu.

Follow the steps below to install Monitor III inWindows�.

Note: Administrative rights on the PC may be required

to install the progam. Contact your system

administrator if you encounter problems during

installation.

Software Installation Procedure

1. Close all applications.

2. Insert the Monitor III Program CD-ROM into the

PC’s CD-ROMdrive, theD: drive onmost systems.

3. Open Windows� Explorer and double-click on the

CD-ROM drive.

4. Double-click on the Setup.exe file.

5. The installation program will guide you through the

installation process. Follow the instructions on the

screen.

Windows�, Windows NT�, and Windows XP� are registered trademarks of Microsoft Corporation.
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6. The program will prompt you to approve or change

the directory for file installation. The setup program

installs the main software files into the C:\Program

Files\DDC MTU\Monitor III directory unless an

alternate location is selected.

7. A window appears when the program is ready to

install the drivers for the hardware keys. Click on

OK to proceed. The program will not operate

without the hardware key and driver.

Note: See Section 2.13.2 if you see an “Invalid

hardware key” message.

8. Click the OK button after the setup is completed.

9. Remove theCD-ROMand store it in a safe location

away from excessive heat, direct sunlight, and

moisture.

Alternatively, use the PC’s Add/Remove Programs

utility. Click on the Startmenu at the lower left corner of

the screen and select Settings→Control Panel. Select

Add/Remove Programs and follow the instructions on

the screen to install the program files as instructed

above.

When the program runs, it generates other files in the

installation directory that the program uses to store

system information.

Perform regular backups of the installation directory.

1.4.2 Software Removal

When updating the Monitor III software, remove the old

version before installing the new one.

To remove the software from the PC, select

Settings→Control Panel→Add/Remove Programs from

the Start menu. Select theMonitor III group and click on

Add/Remove to delete Monitor III Program files from the

installation directory.

Note: Do not simply delete the software files.

Usernames and passwords are saved in a file in the

program directory. If the program directory is not

deleted when the software is updated, the usernames

and passwords are not lost.
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Notes
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Section 2 Software Operation

2.1 Introduction

This section provides general instructions for working

with the Monitor III Program’s tools and windows.

Detailed descriptions of the individual data and setup

windows are given in Sections 3 through 9.

Definitions

Data Window. A window that displays a set of device

parameters or settings. For example, the source

voltages, frequencies, number of phases, and phase

rotation are displayed in the Source Info data window for

an ATS.

Device. A single transfer switch controller, generator

set controller, or power monitor.

Local mode. Communication through a direct

connection between a device and a personal computer.

Remote (modem) mode. Communication through

modem connections.

Remote (network) mode. Communication through an

Ethernet network.

Screen. A collection of open data windows. After

opening and arranging a set of data windows, you can

save the screen to use the same arrangement of data

windows at another time.

SetupWindow. Awindow associatedwith an individual

data window that allows the operator to change settings.

Not all data windows have setup windows associated

with them.

Site. A location including one or more devices

connected to the PC either through a direct connection

or through modems.

2.2 Starting the Program

Start the program by clicking on the Start button at the

lower left corner of the personal computer (PC) screen

and selecting Programs→DDC MTU→Monitor III.

Alternatively, you can create a shortcut to the program

on your PC’s desktop and then click on the shortcut to

start the program. To create the shortcut, go to

C:\Program Files\DDC MTU\Monitor III (or the directory

where the Monitor III program is installed). Right-click

on the Monitor III application file and select Create

Shortcut. Then click on the newly created shortcut and

drag it to your desktop.

2.3 Login

At startup, the programdisplays the login windowshown

in Figure 2-1. Three different security levels allow

program access to supervisors, users, and guests.

Passwords are required to log on to the supervisor and

user levels. A password can also be set for the guest

level.

2.3.1 Supervisor-Level Access

The Supervisor account allows the highest level of

access. A supervisor can:

� Create, edit, and delete sites (see Section 2.5.1)

� Change time delays and other device settings

� Start and stop the generator set (and transfer the load

for ATS devices)

� Monitor all devices in the system.

2.3.2 User-Level Access

The User account allows limited access. An authorized

user can:

� Create, edit, and delete sites (see Section 2.5.1)

� Start and stop the generator set (and transfer the load

for ATS devices)

� Monitor all devices in the system.

The setup windows, which allow users to change

selected device settings, are disabled when the user

logs on as a user or a guest.

USER

Figure 2-1 Login Screen
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2.3.3 Guest-Level Access

TheGuest account allows viewers to log on andmonitor

the system without changing any system settings or

starting/stopping the generator set. Setup and manual

operation windows are disabled when the user logs on

as a guest. A password can be assigned to the Guest

account, if desired. See Section 2.9 for instructions.

2.3.4 Passwords

The factory-default usernames and passwords are

shown in Figure 2-2. Enter the user name and

password and click on the OK button.

Note: Usernames and passwords are case-sensitive.

Type the default username and password using

upper or lower case exactly as shown in

Figure 2-2.

Username Password Access

SUPERVISOR spw Highest

USER upw Limited

GUEST (blank) View Only

Note: Usernames and passwords are case-sensitive.

Figure 2-2 Default Usernames and Passwords

Change the usernames and passwords to prevent

unauthorized personnel from using the program to view

system information, start or stop the generator set, or

change system settings. See Section 2.9 for

instructions.

Selected parameters for the DXPower� 1500 transfer

switch controller require entering an additional

distributor-level password when changing the setting.

These parameters are factory set and should not require

changes unless the controller is replaced. Obtain the

distributor-level password from the DDC/MTU Power

Generation Power Systems Service Department. See

Section 6 for more information.

2.4 Main Window

After login, the program displays the main window with

the welco screen shown in Figure 2-3. Use the buttons

at the upper right corner to resize, minimize, or

maximize the main window.

Use the pull-down menus at the top of the main window

to access the commands shown in the following

sections.

Figure 2-3 Main Window with Welcome Screen
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2.5 File Menu

The file menu includes the following options:

� Manage Sites

� Open Screen

� Save Screen

� Save Screen As

� Restore Setup

� Save Setup

� Exit

The Screen commands are disabled if no windows are

displayed. See Figure 2-4.

Monitor III

Figure 2-4 File Menu

2.5.1 Manage Sites

Use the Manage Sites command to define one or more

sites before attempting to connect for the first time. A

site is a location including one or more devices

connected to the PC either through a direct RS-485

connection or through modems.

Choose File→Manage Sites to open the Site

Management window. The Site Management window

allows a supervisor or user to create, edit, or delete a

site. See Figure 2-5.

Note: User- or Supervisor-level access is required in

order to access the Manage Sites command.

Guests cannot create, edit, or delete sites.

New. Use New to create sites and set up their

communication parameters before connecting. Click on

New to open a blank Site Setup form. See Figure 2-6.

All sites that have been set up are displayed on the left

side of the Site Management screen. Up to 256 sites

can be displayed. A scroll bar will appear on the side of

the list box if there are more sites than can be displayed

at one time. Click on a name in the list to select a site and

then choose Delete, Edit, or Done.

Delete. UseDelete to remove the selected site from the

list. The Delete button is disabled if no site is selected.

Figure 2-5 Site Management Screen

Figure 2-6 Site Setup Screen
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Edit. Use Edit to change the site name or

communication parameters, or to add, edit, or delete

individual devices from the selected site. Clicking on the

Edit button opens the Site Setup screen shown in

Figure 2-6. Refer to Section 2.5.2 for instructions to edit

the parameters in this screen.

Done. After creating and editing sites, select the Done

button at the bottom of the screen to close the Site

Management screen.

2.5.2 Creating or Editing a Site

Note: User- or Supervisor-level access is required in

order to access the Manage Sites command.

Guests cannot create, edit, or delete sites.

Selecting New or Edit from the Site Management

window opens the screen shown in Figure 2-6.

Complete all fields that are not disabled (grayed out) in

the Site Setup screen. When finished, click on OK or

press Enter to save any changes made to the sites.

Click on Cancel to discard changes without saving.

Site Name (optional). Create a unique name to identify

the site and type it into the Site Name box. Use a

different name to identify each site.

Local Monitoring. Select Local if the site is connected

directly to the PC using an RS-232 or RS-485

connection.

COMPort Number. Select theCOMport number

used to connect the PC to the device.

Note: Communications problems at startup are

often caused by an incorrect COM port

selection. If the PC does not communicate

with the connected devices, try another

COMport number. Numbers 1 through 4 are

commonly used, but they can go as high as

256.

BaudRate. To set thebaud rate for thePC, click on

the drop-down arrow next to the Baud Rate box to

display a list of available baud rates. Select the

baud rate to match the baud rate on the connected

devices.

Note: The same baud ratemust be used on thePC

and all connected devices.

Remote (modem). Select Remote (modem) if modems

are used to connect the PC to the site. (The PCmay use

an internal modem.)

Modem. The program displays the modems found

on the PC. Click on the down arrow next to the

Modem box and select the PC modem.

Phone Number. Type the phone number for the

site (device) modem into the Phone Number box,

including the area code and any special characters

needed. Use a comma to insert a slight pause if

necessary.

Example: 9,1,9205551212 dials 9 for an outside

line, pauses, dials 1 for a long distance number,

pauses, then dials the area code and number,

9205551212.

Remote (network). Select Remote (network) for an

Ethernet (TCP/IP) network connection.

IP Address. Enter the IP address for the

Modbus/Ethernet converter used with the

connected devices. See Instruction sheet TT-1405

for instructions to assign the IP address to the

converter. Required for Ethernet (TCP/IP)

connections only.

Add Device. Click on AddDevice to add a device to the

site. All sitesmust have at least one device. TheDevice

Screen will appear. See Figure 2-7.

Address. Enter the device’s network address

(number 1--247). Each device in a sitemust have a

different network address.

Note: The address entered here must match the

network address that was assigned to the

device using the device keypad or DIP

switches. TheMonitor III program cannot be

used to assign or change a device’s network

address. See TT-1405 and the controller

Operation Manual. See the List of Related

Literature.

Description (optional). Type in a unique

description for each device at the site. For

controllers that have previously-assigned device

designations or names, use that designation to

avoid confusion. Refer to the controller operation

manuals for instructions to assign the device

designation.

Figure 2-7 Device Screen
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2.5.3 Copying Site Setup Information

Site setup information is stored in a file called site.dat

and stored in the same directory as the Monitor III

program files. To set up the same sites on more than

one PC, copy the sites.dat file after completing the site

setup. Be sure to paste the file in the same directory as

the Monitor III program files.

Note: Do not edit the sites.dat file.

2.5.4 Save Screen and Open Screen

Screens can be saved to a file for reuse. Screens can

include datawindows for one ormore devices at a single

site. After creating the desired data windows and

arranging them on the PC screen, use the following

procedure to save the layout. Use the Save Screen As
command to create a new file or Save Screen to update

an existing Screen file.

Note: The Save Screen command does not save

system settings (source parameters, time delay

settings, etc.).

Procedure to Save a Screen to a File

1. Select File→SaveScreen As from themenu bar as

shown in Figure 2-4.

2. A dialogue box appears. See Figure 2-8. Type in a

filename for the screen file. Choose a unique name

that identifies the file for future reference. Screen

files use the extension .scn. Do not type the

filename extension; the program appends the

extension to the filename automatically.

3. Click on the Save button.

Monitor III

Figure 2-8 Save Screen

Procedure to Open a Saved Screen

The Open Screen command opens a file containing

previously created data windows.

Note: You must connect to a site before opening a

screen file.

Select File→Open Screen and then select the

appropriate file from the list on the screen. Use the

drop-down arrows to change directories if the file is

located in a different directory than the one displayed in

the Look in: box. With the file selected, click on theOpen

button. The saved screens appear in the program’s

main window when the file opens.

2.5.5 Save Setup and Restore Setup

The Save Setup and Restore Setup commands allow

you to save device settings for time delays, input/output

assignments, and any other settings that can be

adjusted through Monitor III. This function only applies

to the Digital 550 generator set controller and the

DXPower� 1000 transfer switch controller.

Settings can be made on one device, then saved and

applied to other devices of the same type. These

functions can be useful for controller replacement or to

speed the setup ofmultiple controllers that use the same

settings.

Procedure to Save Device Settings

1. Use the setup windows to set the desired time

delays, inputs/outputs, and other settings on the

device.

2. Select File→Save Setup from the menu bar as

shown in Figure 2-4.

3. The Save Setup window appears. See Figure 2-9.

Click on the device in the list and then click OK.

4. A dialogue box similar to the one shown in

Figure 2-8 appears. Use the drop-down arrows to

change directories if you need to save the file in a

different location.

Type in a filename for the data file. Choose a

unique name that identifies the file for future

reference. Do not type the filename extension; the

program automatically appends the extension .sdf.

Click on the Save button.
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Figure 2-9 Save Setup

Procedure to Restore Device Settings

1. Select File→Restore Setup from the menu bar as

shown in Figure 2-4.

2. The Restore Setup window (similar to the Save

Setup window shown in Figure 2-9) appears. Click

on the device in the list and then click OK.

3. A dialogue box listing the files appears. Use the

drop-down arrows to change directories if the file is

located in a different directory than the one

displayed. Setup data files use the extension .sdf.
Select the setup data file that contains the desired

settings and click on the Open button.

2.5.6 Exit

Use the File→Exit command to exit the Monitor III

Program after disconnecting from the site (see

Section 2.6, Connection Menu).

The message shown in Figure 2-10 appears at exit if

any data windows have been added or removed. The

Save Screen command allows the displayed set of data

windows to be saved and then reopened later,

eliminating the need to open and position the windows

individually at each use of the program. Select Yes to

save, No to exit without saving, or Cancel to cancel the

exit command and return to the program. See Section

2.5.4 for more information.

Monitor III

Figure 2-10 Save Screen
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2.6 Connection Menu

The Connect command attempts to open the

communication port and establish communications with

a site. See Figure 2-11.

Note: Each device must be configured for Modbus

communication. Refer to the controllerOperation

Manual for instructions.

Select Connection→Connect to open the Connect

windowshown in Figure 2-12. Click on one site in the list

to select it, then click on the Connect button at the

bottom of the window to connect to that site. The Site

Overview window automatically appears after

connection. See Section 2.7 for instructions for using

the Site Overview window.

The Disconnect command closes the communication

port.

Note: Monitor III communicates with one site at a time.

Disconnect before attempting to connect to

another site.

Figure 2-11 Connection Menu

Figure 2-12 Connect Window
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2.7 Site Overview Window

Connecting to a site opens the Site Overview window

shown in Figure 2-13. For transfer switch controllers,

the Site Overview window displays the ATS position

(Normal, Off, or Emergency), the available sources, and

system status for each device at the connected site. For

generator sets and powermonitors, the system status is

displayed in the lower part of the window as shown.

2.7.1 ATS Controllers

Site Name. The site name appears at the top of the

window. The site name was assigned using the Site

Setup Screen under the Site Management window. See

Section 2.5.1.

Addr (address). TheAddr (address) column shows the

network address for each ATS at the site. The network

address must be assigned at the device and entered

into Monitor III during device setup. See Section 2.5.2.

Description. The Description column displays the ATS

description that was assigned during the device setup.

See Section 2.5.2, Creating or Editing a Site. Assign a

unique description to each ATS for identification.

Position. The Position column shows the contactor

position, Normal, Emergency, or Off (programmed-

transition models only). The color of the box also

indicates position:

� Green when the contactor is in the Normal position

� Yellow when the contactor is in Off

� Red when the contactor is in Emergency

Normal Available, Emergency Available. An X in the

Normal Available and/or Emergency Available columns

shows that the indicated source is available.

Status. The Status column displays messages

indicating the condition of the device. Some possible

system status messages are:

� System Ready

� Test Running

� Fault

� Lost Communications

� Failure to Acquire Standby

If one of the devices indicates a fault condition, the

status box for that switch displays a fault message and

the display flashes red.

Figure 2-13 Site Overview Window

ATS 1000

MATS+

550

DIGITAL

16-LIGHT
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2.7.2 Generator Set Controllers and

Power Monitors

Description. The Description column displays the

description assigned when the site was created. See

Figure 2-7. Assign a unique description to each

controller or power monitor for identification.

Status. The Status column displays messages

indicating the condition of the device. Some examples

of system status messages are:

� System Ready (all except 550-series controllers)

� Generator Running (all controllers)

� Fault codes (some controllers)

� Lost Communications (check connections)

If one of the devices indicates a fault condition, the

status box for that device displays a fault message and

flashes red.

2.7.3 Opening Data Windows from the

Site Overview Window

Data windows can be opened from the Site Overview

window. See Figure 2-13. Double-click on the device in

the Site Overview table to open the AddWindow screen

for that device. SeeFigure 6-1. Or, use theAddWindow

screen to open any available data window for the

selected device.

See Section 2.10 for more information about adding and

using data windows.

When the Site Overview window is closed, the

Window→NewWindow command can be used to open

data windows. See Section 2.10.

2.8 Edit Menu

The Edit menu allows the user to cut, copy, and paste

selected text. SeeFigure 2-14. With some systems, the

Edit commands can be accessed by clicking the right

mouse button while the setup window is active.

The Cut and Copy commands are enabled only when

text that can be cut or copied is selected. The Paste
command is only enabled when there is text on the

clipboard that is available to paste.

Monitor III

Figure 2-14 Edit Menu



MP-6347 9/0626 Section 2 Software Operation

2.9 Tools Menu

Use the Tools menu to change the software user name

and password and to set the PC’s communication

settings. See Figure 2-15.

Figure 2-15 Tools Menu

2.9.1 Change Password

Use this window to change the password. See

Figure 2-16. The default passwords are shown in

Figure 2-2.

Log in at the level to be changed (supervisor, user, or

guest). The window displays the name of the user

logged on to the program. Type in the old password, the

new password, and the new password a second time for

confirmation. To ensure confidentiality, the passwords

do not appear on the screen. Click on the OK button to

enter the new password. Click on the Cancel button to

discard the changes and keep the old password.

Note: Passwords and user names are case-sensitive.

Use upper and lower case letters as you want

them to be typed at login. Check the Caps Lock

key when typing passwords.

USER

Figure 2-16 Change Password

2.9.2 Change User Name

Use this window to change the user name of the person

who is logged in. See Figure 2-17. The default

usernames are shown in Figure 2-2.

Log in at the level to be changed (supervisor, user, or

guest). The window displays the current user name

near the top. Type in the new user name and type it

again in the second box to confirm it. The new names

appear on the screen as they are typed. Click on OK to

accept the new user names, or Cancel to discard the

change and keep the old user name.

The program verifies that the new names match before

accepting the change.

Note: Passwords and user names are case-sensitive.

Use upper and lower case letters as you want

them to be typed at login.

USER

Figure 2-17 Change User Name
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2.10 Window Menu

Use the Window menu to open new data windows,

select an open window, enter the setup screen for an

existing window, arrange windows on the screen, and

delete windows. See Figure 2-18.

This section gives general instructions for creating and

working with data windows. Refer to Sections 3 through

9 for detailed descriptions of the available windows for

each device.

Note: You must be connected to a site in order to add a

window.

2.10.1 New Window

The New Window command creates data windows on

the screen. Connect to a site before trying to create data

windows. See Section 2.6.

Select Window→New Window... from the main window

pull-down menus. The program displays the Add

Window screen shown in Figure 2-19.

The list on the left side of the Add Window screen

contains all devices at the connected site. Click on one

device in the list to select that device. Then select one or

more data windows from the list on the right side of the

screen. You can select multiple items from the list by

holding down the control (Ctrl) key and clicking on each

item. Or, select blocks of items by clicking on the first

item, then holding down the Shift key while clicking on

the last item in the block. The selected datawindowswill

be highlighted. Click onOK to open the highlighted data

windows for the selected device.

Monitor III

Figure 2-18 Window Menu

Figure 2-19 Typical Add Window Screen
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To create data windows for a different device at the

connected site, click on the device designation in the list

on the left side of the screen. The available data

windows for that device will be listed on the right side of

the screen.

Data windows that have already been added to the user

screen do not appear on the list. If all datawindowshave

been added to the user screen, the list is empty.

Click on Cancel or the X button at the upper right corner

of the screen to return to the main window.

See the individual device sections of this manual for

more information about available data windows for that

device.

2.10.2 Working with Data Windows

Data Window Title Bar

The colored title bar at the top of thewindowcontains the

following information for the device:

� Network address

� Description (entered in the Add Device screen; see

Section 2.5.2)

� Data window name, in brackets (factory-set)

Long device descriptions may cause the title bar

information to be cut off in some smaller data windows.

Place the cursor over the title bar to display the entire

line.

Data Window Size

If part of a data window is not visible on the screen, try

the following solutions (see Figure 2-20):

� Click on the maximize button to expand the main

window to full size.

� Move the data window by clicking in the title bar and

dragging the window to a better location.

� Use the scroll bars on the main window to view the

other part of the screen.

� Change the screen area of your PCmonitor to 1024X

768 pixels or more:

� Select Start→Settings→Control Panel.

� Click on Display, choose the Settings tab, and find

the Screen Area setting. Slide the bar in the More

direction to increase the number of pixels.

� Click on Apply and then OK. Click on Yes to keep

the new settings if you are happy with the result.

Note: Changing the monitor screen area will affect the

look of other applications on the PC.

1

6347

1. Maximize button

2. Scroll bars
3. Title bar (click and drag to move window)

2

3

Figure 2-20 Working with Data Windows
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2.10.3 Setup Windows

Setup windows allow you to change selected settings

for the Digital 550 generator set controller and the

DXPower� 1000 ATS controller.

First select the data window for the function that you

want to work with. Then choose Window→Setup or

double-click on the active datawindow to open the setup

window for that function. Figure 2-21 shows a typical

data window with its corresponding setup window.

Note: The data window for a function must be open and

selected before the setup window can be

opened. The Setup command is grayed-out if the

selected data window does not have a setup

window associated with it.

When the user presses the OK button or Enter, all of the

settings will be sent to the controller. If the user presses

Cancel or X, the screen will be dismissed without

warning and no changes will be made.

The setup windows use several methods to enter

system information and settings. This section gives

general instructions about how to use the different

methods to enter information.

Radio Buttons. A radio button appears as an open

circle. Position the cursor inside the open circle and

left-click to select the desired option. The selected radio

button has a dark dot in the center. Radio buttons allow

the selection of only one of the options in a set.

Selecting one radio button in a set of options deselects,

or turns off, all of the other options.

Check Boxes. Check boxes are open rectangular

boxes. A selected check box contains a check mark.

Position the cursor inside the box and click to select or

deselect the option. Check boxes allow the selection of

any or all of the options in the set. Selecting one option

with a check box will not deselect the other options in a

set.

Data Entry Boxes. Data entry boxes allow you to type

in text or numerical data from the keyboard. Position the

cursor inside the box, left-click, and type in the new

information. If the box already contains information,

double-click to highlight the text before typing the new

information. Some items show the acceptable range of

settings after the data entry box. Verify that the data you

enter falls within the range shown. If the setting does not

fall within the acceptable range, the system will not

accept the change.

Drop-Down Arrows. A drop-down arrow appears as a

down arrow in a box at the end of a line. Position the

cursor on the down arrow and click to display a selection

list. Click on an item in the list to select it. The selected

item appears in the box next to the arrow.

Up and Down Arrows. Up and down arrows appear in

boxes after a data entry box containing a numerical

setting. Click on the up arrow to increase the number or

the down arrow to decrease the number. You can also

double-click inside the data box and type in the setting

directly, provided it falls within the acceptable range.

Password Boxes. Selected parameters for the

DXPower� 1500 transfer switch controller require

entering an additional distributor-level password when

changing the setting. These parameters are factory set

and should not require changes unless the controller is

replaced. Type the password into the box provided

before clicking on OK to change the setting. See

Section 6 for more information.

OK and Cancel Buttons. The OK and Cancel buttons

appear at the bottom of each window. Make changes to

the selections or data entry boxes, and then click onOK

to accept the changes and enter them into the system. If

the OK box is highlighted on the screen, pressing the

Enter keywill also enter the changes. Click onCancel to

discard the changeswithout sending them to the device.

Note: The software does not send changes to the

device until the OK button is clicked.

Confirmation Boxes. Clicking on OK to enter some

changes prompts a confirmation box to appear on the

screen before the system sends the changes to the

device. Double check your selections and their effect on

the system before clicking on OK to confirm the

changes.

1

t6347

1. Data window

2. Corresponding setup window

2

Figure 2-21 Data and Setup Windows (typical)
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2.10.4 Add Site Overview

If the Site Overview window has been closed, select

Window→Add Site Overview to open it again. See

Figure 2-13.

2.10.5 Arrange Icons

Minimizing windows by clicking on the
--

symbol in the

upper right corner of the window reduces the window to

an icon. SelectWindow→Arrange Icons to arrange the

icons neatly at the bottom of the main window.

2.10.6 Cascade Windows

Choose Window→Cascade Windows to arrange the

windows on the screen. The Cascade Windows
command is enabled only when two or more data

windows are on the screen.

2.10.7 Display Windows

Choose Windows→Display Windows to see a list of all

windows that have been created on the screen. Select a

window from the list to bring it to the top and activate it.

2.11 Help Menu

Choose Help→About... for information about the

software. See Figure 2-22.

Monitor III

Figure 2-22 Help Menu

The Help Topics option contains the contents of this

instruction manual in a .pdf file format. Adobe�

Acrobat� or Adobe� Reader� is required to display the

Help file.

The About... box displays the software name, version

number, build date, and copyright information. Record

the software version number on the inside front cover of

this manual for future reference.

Click on the System Info button to launch the Microsoft�

system information application if it is available on your

PC.

Click on the OK button to close the window.

2.12 System Tray

An icon in the box at the lower right corner of the screen

indicates whether the PC is connected to the site. See

Figure 2-23.

� A green icon indicates that the PC is communicating

with the site.

� A red icon indicates that the devices are not

connected.

If there are connection problems, check the selected

COMport and the hardware connections (seeTT-1405).

1

1. Connection icon: green=connected, red=disconnected

Figure 2-23 System Tray

Adobe� Acrobat� and Adobe� Reader� are registered trademarks
of Adobe Systems Incorporated.
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2.13 Error Messages

Message windows indicate errors or prompt the user to

save the screen before exiting.

2.13.1 Incorrect User Name or Password

The following messages may appear:

� The user name or password is incorrect. User names

and passwords are case sensitive. See Figure 2-24.

This message can appear when the username or

password is being changed or if the user tries to enter

an old user name/password combination.

� The new passwords typed do not match. See

Figure 2-25.

� The usernames typed do not match. See

Figure 2-26.

If any of thesemessages appear, check the spelling and

capitalization of the password or username carefully,

and then retype it in both boxes.

Note: Passwords and usernames are case

sensitive. Check the Caps Lock key before

typing.

Figure 2-24 Login

Figure 2-25 Change Password

Figure 2-26 Change User Name

2.13.2 Invalid Hardware Key Message

On some systems, Monitor III may display an error

message when the USB hardware key is applied. See

Figure 2-27. The error is the result of a compatibility

issue between the USB hardware key and the Microsoft

Windows operating system on your personal computer.

The error has been known to occur with various

Microsoft� Windows� Win32 and Win64 applications.

If the error appears, you must download a new device

driver to support the hardware key. Go to

http://www.aladdin.com/support/hasp/hasp4/enduser.asp

and select the device driver appropriate to your PC

operating system. A link to the site is also provided on

Tech Tools on the Kohlernet. Go to www.kohlernet.com

and use your SecurID Card to log in. Click on Tech

Tools, then Software, then Monitor III and then the link.

Select the file for the HDD32 device. Follow the

instructions in the readme.txt file associated to the

download.

Figure 2-27 Invalid Hardware Key Message

Windows� is a registered trademark of Microsoft Corporation.
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2.13.3 Missing Hardware Key

Themessage shown in Figure 2-28 appears at program

startup if the harware key is not inserted into the PC’s

USB port.

A red LED on the key indicates that the key is activated.

If the message appears when the key seems to be

properly inserted, contact your system administrator.

Figure 2-28 Missing Hardware Key

2.13.4 Failed to Start Messages

The following error messages are related to the

hardware key device driver:

� Failed to Start the Aladdin Device Driver

� Failed to Start a Service in the Service Control

Manager Database

If one of these messages appears, follow these steps to

reinstall the HASP device driver:

Procedure to Reinstall Hasp Device Driver

1. On your PC, go to:

C:/Program Files/DDC/MTU/ MonitorIII.

2. Click on hdd32.exe and follow the instructions on

the screen to reinstall the device driver.

2.13.5 Communication Errors

A Lost Communication error message can indicate a

physical loss of connection or a problem with

communication settings. Check connections, controller

settings, and the site settings in Monitor III. See

TT-1405 and Section 2.5.2 of this manual.

Monitor III may appear to stop communicating if the user

attempts to change a parameter that cannot be

changed. For example, attempting to change 550

controller settings when the controller is set to the Local

programming mode will cause Monitor III to seem to

stop communicating as it repeatedly attempts to change

the setting.



MP-6347 9/06 33Section 3 550 Generator Set Controller

Section 3 550 Generator Set Controller

3.1 Introduction

The Monitor III Program allows viewing and adjustment

of selected settings for generator sets equipped with the

550 controller. The software provides the following

functions.

� Manual operation (password-protected):

� Start and stop the engine

� Timed run

� Reset maintenance records

� Reset faults

� View and adjust (password-protected):

� Analog input settings

� Common alarms

� Date and time

� Digital input settings

� Generator information, including nominal ratings,

connection type, and operating mode

� Relay driver output assignments, status, and

settings

� System information, including generator set name,

location, and description

� View only:

� Analog input status

� Electrical information, including voltage,

frequency, current, and power

� Engine status information

� Event history

� Maintenance information

� Factory-set system information, including

specification numbers and serial numbers

The view only items listed above can be changed using

the controller keypad. See the controller Operation

manual.

Some information displayed on the 550 controller is not

displayed in Monitor III. For example, some information

for DDEC or MDEC-equipped engines shown in the

550’s Menu 2 is not displayed inMonitor III. See the 550

Controller’s Operation Manual.

TheMonitor III Programcannot be used to view or adjust

the controller’s communication settings, i.e. the network

address or the network interface baud rate. Use the

controller keypad to view and adjust communication

settings.

3.2 Controller Connection and

Setup

Refer to TT-1405, provided with the Monitor III software

kit, for controller connection and setup instructions.

Connect the controller to the PC or network and

configure the controller for communications. Refer to

the controller Operation Manual for instructions to use

the controller’s keypad to set the communications

parameters.

Use the controller’s keypad to set the communication

protocol in Menu 13 to Modbus Online. Use the keypad

to set the programming mode in Menu 14 to Remote in

order to use Monitor III to change controller settings. If

the programming mode is set to Local, Monitor III can

display the controller settings but not change them.

Set the other communication parameters as required for

the connection type as described in TT-1405.
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3.3 Data Windows

Select Window→NewWindow to open the AddWindow

screen. Select the generator set/controller from the list

on the left. The available data windows for the selected

controller appear on the right. Figure 3-1 illustrates the

list of available data windows for the 550 controller.

The Manual Operations window allows remote starting

and stopping of the generator set, resetting faults, and

resetting maintenance records. User or supervisor

access is required to perform Manual Operations.

Setup windows are available for some windows. The

setup windows allow changes to selected controller

settings including system parameters, time delays, trip

points, alarms, inputs, and outputs. Supervisor-level

access is required to access the setup windows. Figure 3-1 Add Window

3.4 Data Window Summary Table

The following table summarizes the available data windows and indicates which setup windows are available. More

details about selected data windows are given after the table.

Data Window Display Setup Item Notes

Analog Inputs X Battery Voltage VDCg p

Aux. Analog Inputs #1--#7

Analog Input
S i

X X * Aux. Analog Inputs #1--#7 High Shutdown Limit �g p
Settings

g p

High Warning Limit �

Low Warning Limit �

Low Shutdown Limit �

Inhibit time, 0--60 sec.

Warning time, 0--60 sec.

Shutdown Time, 0--60 sec.

Shutdown Enabled/disabled (checkbox)

Warning Enabled/disabled (checkbox)

Common
Alarms

X X Assigned common alarms Add and remove items from the common alarm. See
the controller Operation Manual for available alarms

Date/Time X X Date/

Time

Synchronize with Computer
Button (setup only)

Digital Inputs X X Function Assignedg p

Inhibit Time minutes:seconds (mm:ss)

Delay time minutes:seconds (mm:ss)

User-assigned description Type custom description in setup window

Enable/disable (setup only) Checkbox (setup only)

Electrical Info X Frequency Hz

% of Rated kW % (percent)

Voltage L1--L2 Line-to-line voltage

Voltage L2--L3

g

X Voltage L3--L1 Line-to-line voltage

Voltage L1--L0 Line-to-neutral voltage

Voltage L2--L0

g

* Double click on one analog input in the data window to open the setup window for that input only.

� For analog input settings, enter the scaled values appropriate to each sensor.
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Data Window NotesItemSetupDisplay

Electrical Info,
i d

X Voltage L3--L0 Line-to-neutral voltage,
continued Current L1 Amps

Current L2

p

Current L3

Power Factor Total, L1, L2, and L3; leading or lagging

kVA Total, L1, L2, and L3

kW Total, L1, L2, and L3

kVAR Total, L1, L2, and L3

Engine Info
( i d fi d

X Speed RPMg
(units defined at
controller)

Oil Pressure
controller)

Temperature

Level

Crankcase pressure

Coolant Pressure

Temperature

Level

Battery ECM Voltage, VDC

Fuel Pressure

Temperature

Burn Rate

Last Run Consumption

Intake Air Filter Diff. Pressure

Temperature

Event History X Date, time, and event Up to 100 events with up to two parameters per event
can be displayed

Save History button Saves to an ASCII text .log file. Operator enters the
filename and path.

Generator Info X X Genset Rating kW

Nominal Voltage System voltage

Nominal Frequency System frequency, Hz

Nominal Battery Voltage VDC

Phases 1 or 3

Connection Wye or Delta (3-phase)

Operating Mode Standby or prime power

NFPA 110 Defaults Enabled/Disabled (checkbox)

Maintenance X Run time Total and since last maintenance

Loaded run time

Unloaded run time

kW hours

Number of starts

Last maintenance date See Manual Operations to reset

Operating days

Last Run Date

Time

Run time

Loaded or unloaded
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Data Window NotesItemSetupDisplay

Maintenance,
i d

X Timed Run Engine run time, 0:01--72:00 hours:minutes,
continued Set run time

Start engine button

Stop engine button

Reset maintenance records
button

Reset faults button

RDO Summary X X Relay Driver Output
assignments, ON/OFF

Click on the each line to set up single RDOs. See the
controller documentation for available functions.

X Software-controlled RDOs Turn each SCRDO on or off (checkbox)

X Setpoints Select high shutdown, high warning, low warning, or
low shutdown for selected functions

System Info X X Genset Name User-defined, setup windowy

X Location

, p

X Description

Final Assembly Date Factory-set, not adjustable

Final Assembler’s clock
number

y , j

Model Number

Specification Number

Genset serial number

Controller serial number

Engine part number

Alternator part number

Software version number

Time Delays X X Engine Start 0:00--5:00 minutes:secondsy

Engine Cooldown 0:00--10:00 minutes:seconds

Overvoltage 2--10 seconds

Undervoltage 5--30 seconds

Starting Aid 0--10 seconds

Load Shed 2--10 seconds

Crank On 00:01--01:00 minutes:seconds

Crank Pause 00:01--01:00 minutes:seconds

Max. Crank Cycles 1--6

Trip Points X X Load Shed Output % of rating and kWp

Overvoltage % of nominal and Volts

Undervoltage % of nominal and Volts

Overfrequency % of nominal and Hz

Underfrequency % of nominal and Hz

Overspeed Hz and RPM

High Battery Voltage VDC

Low Battery Voltage VDC
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3.5 Analog Inputs

The Analog Inputs data window shows the status of

each analog input.

Figure 3-2 Analog Input Values (display)

3.6 Analog Input Settings

The Analog Input Settings window displays the warning

and shutdown limits and time delays for each analog

input and allows adjustments to the settings. See

Figure 3-4.

Open the Analog Input Settings data window and then

use the instructions in the following procedure to change

settings. The setup window for only one input can be

open at a time.

Changing Settings

Position the cursor on the input to be changed and

double click to open the setupwindow for that input. See

Figure 3-3.

1. Type a descriptive name for the input into the

Description box.

2. Select warning or shutdown by clicking on the

appropriate box.

3. Enter the limits and time delays in the boxes

provided. For the limit settings, enter the

appropriate scaled value for each input sensor.

See MP-6140, Controller Application and Setup

Manual, for instructions to calibrate analog inputs.

4. Click OK to send changes to the device or Cancel

to discard the changes.

Figure 3-3 Analog Input Setup Window for a Single

Analog Input (example settings shown)

Figure 3-4 Analog Input Settings Display Window
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3.7 Common Alarms

3.7.1 Common Alarm Display

Use this window to view the events that are assigned to

the controller’s common fault.

If more events are assigned to the common fault than

can be displayed in the text box, the scroll bars are

enabled.

3.7.2 Common Alarm Setup

Double click anywhere on the common alarms data

window to open the setup window.

Use this window to assign events to the controller’s

common alarm.

All events assigned to the common fault are displayed in

the Assigned Events box on the right. Any events not

assigned to the common fault are displayed in the

Available Events box on the left. Note that these boxes

are mutually exclusive so an event will not appear in

both.

Click the Add button to move the selected events in the

left box into the assigned box. Press the OK button to

send the events to the controller. If no events in the left

box are selected, the Add button is disabled.

Clicking the Remove button will move any selected

events in the right box into the available box. If noevents

in the right box are selected, the Remove button is

disabled.

Clicking the Select All or Clear All buttons will select all

remaining or clear all selected events respectively from

the box above the button pair. If there are no events in a

list box, its associated Select All and Clear All buttons

are disabled.

If no events are selected in a text box, its associated

Clear All button is disabled.

If more events are in a text box than can be displayed,

the scroll bar for that box is enabled.

Figure 3-5 Common Alarm Display Window

Figure 3-6 Common Alarm Setup Window
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3.8 Date and Time

3.8.1 Date and Time

Use this window to view the controller’s time and date

settings.

3.8.2 Date and Time Setup

Double click anywhere on the date and time data

window to open the setup window.

Use this window to set the controller’s time and date.

The setup window displays the controller’s time at the

moment the window was loaded. The time is not

updated as in the Date/Time data window.

The date and time can be entered directly by selecting

the pick boxes and typing the value.

Press the down arrow on the date box to select a date

from 01/01/2000 to 12/31/2156.

Clicking the Synchronize with Computer button sets the

date & time fields tomatch the computer’s system clock.

Figure 3-7 Date/Time Data Window

Figure 3-8 Date/Time Setup Window
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3.9 Digital Inputs

3.9.1 Digital Input Display

The Digital Input data window displays the functions,

time delays, and descriptions for all assigned digital

inputs. See Figure 3-10.

If an input is disabled, the text is gray.

3.9.2 Digital Input Setup

Use this window to set up a single digital input on a

controller.

Double click on any input in the data window to open the

setup window for that input only. Using the scroll bar to

view available functions, select the desired function

from the list. Click on the Enable box to enable or

disable the input. A check mark in the box indicates that

the input is enabled. Enter the inhibit time and delay

time in minutes:seconds. Type in a description, which

will appear in the User Assigned Description Area of the

data window, if desired.

Click OK to send the changes to the controller or Cancel

to discard changes and close the setup window.

Figure 3-9 Digital Input Setup Window for a Single

Digital Input

Figure 3-10 Digital Input Display Window
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3.10 Electrical Info

This window displays information about electrical power

being delivered by the controller’s generator set. There

is no setup window for this information.

Figure 3-11 Electrical Info Display

3.11 Engine Info

This window displays engine information available to

the DEC550 controller. There is no setup window.

The window will display the samemeasurement system

(English/Metric) as the controller.

ECM Voltage will change to Local Voltage if the

controller is configured for a non--ECM engine.

Figure 3-12 Engine Info Display Window
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3.12 Event History

Use this window to view and save the controller’s event

log. The events displayed in this windoware theSystem

Events displayed in Menu 10 on the 550 controller

display. See the controller’s Operation Manual for more

information about system events.

The window will display all the events in the controller’s

event log, the time and date of the events, and up to two

parameters associated with the event.

If there is at least one event in the log, the Save

History… button is enabled. To save the history to a file,

press the Save History… button and then select or enter

a name and path for the directory to save the log. The

file is an ASCII text file with a default file extension of log.

Up to 100 events may be displayed. If more events are

in the log than can fit in the event list box, scroll bars will

appear on the right side.

Figure 3-13 Event History Display Window
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3.13 Generator Info

3.13.1 Generator Info Display

This window will display electrical information about the

generator set’s alternator.

Double click anywhere on the window to open the setup

window.

3.13.2 Generator Info Setup

Double click on the Generator Info data window to open

the setup window. Use this window to change the

voltage and frequency data for the generator set. Enter

the corresponding data if the generator set requires

voltage reconnection and/or frequency adjustment.

Note: It is imperative that the user enter the correct data
because these settings trigger all related

shutdowns.

Note: The user defines the data shown. It is NOT data

measured by the controller and associated

sensing devices. The user defines these values

for purposes of calibrating the control.

Figure 3-14 Generator Info Display Window

Figure 3-15 Generator Info Setup Window
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3.14 Maintenance History

3.14.1 Maintenance History Display

This window displays maintenance and some historical

information about the generator set.

Double clicking anywhere on the window will open the

Manual Operations window.

3.14.2 Remote Maintenance Setup

(Manual Operation)

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator
set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.

(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote
computer.

Double click anywhere on the Maintenance data

window to open the Remote Maintenance Operations

window. This window allows supervisors and users to

remotely start and stop the generator set.

Note: Supervisor-level access is required to reset faults

and maintenance records.

The command to perform the requested operation is

sent immediately when a button on this window is

pressed. Pressing the Close button does not send

commands to the generator set.

For remote starting and stopping, the generator set

master switchmust be in the AUTOposition. To start the

generator set from the computer, type the desired

engine run time in hours:minutes into the box provided

and click on the Set Run Time button. Then click on the

Start Engine button to send the engine start signal to the

generator set. The generator set will start and run for the

time entered in the Run Time box. To stop the generator

set before the run time has elapsed, click on the Stop

Engine button.

Click the Reset Maintenance Records button after

performing the scheduled generator set maintenance

described in the generator set’s Operation Manual.

Resetting the maintenance records updates the Last

Maintenance Date and times since maintenance shown

in the Maintenance Display window.

Figure 3-16 Maintenance Display Window

Figure 3-17 Remote Maintenance Setup Window

(manual operation)
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3.15 Relay Driver Outputs (RDO)

3.15.1 RDO Summary

Use this window to view the controller’s relay driver

output (RDO) settings.

Double click on any line to open the setup window for

that RDO only.

3.15.2 RDO Setup

This window allows the user to set up a single Relay

Driver Output (RDO).

The Set Points radio buttons are enabled when the user

selects an analog input for assignment to the RDO.

Select high or low warnings or shutdowns.

The window will also allow the user to turn a Software

Controlled RDO (SCRDO) on or off. The Software

Controlled RDO ON checkbox is active for SCRDOs

1--4.

Enabling NFPA-110 defaults (see Figure 3-15,

generator info setup), sets selected RDOs to default

values. These RDOs cannot be changed from the RDO

Setup Screen when NFPA-110 defaults are enabled.

Click on OK to save changes, or Cancel to discard

changes.

Figure 3-18 RDO Summary Display Window

Figure 3-19 RDO Setup Window
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3.16 System Info

3.16.1 System Info Display

Use this window to display the system information

strings and serial numbers. The top three items are

user-defined and can be changed through the setup

window. All other information in this window is

factory-set and cannot be changed through Monitor III.

Figure 3-20 System Info Display Window

3.16.2 System Info Setup

Double click anywhere on the System Info data window

to open the setup window.

Create your own descriptions to identify the generator

set by name, location, and load description. Type in the

descriptions and click onOK. These descriptions will be

used in the System Info Display window to identify the

generator set.

Figure 3-21 System Info Setup Window

3.17 Time Delays

3.17.1 Time Delay Display

Use this window to view the controller’s time delay

settings in minutes:seconds. The maximum crank

cycles is shown in number of crank attempts.

Double click anywhere on the window to open the setup

window.

Figure 3-22 Time Delay Display Window

3.17.2 Time Delay Setup

Use this window to change the controller’s time delay

settings. Type in the desired settings in

minutes:seconds. The setting must be within the range

shown directly to the right of each box.

For Max. Crank Cycles, type in the maximum number of

starting attempts (from 1 to 6) to allow before shutting

down on an overcrank fault.

Click on the OK button to enter the new settings and

close thewindow. Clicking onCancel closes thewindow

without changing the settings.

Figure 3-23 Time Delay Setup Window
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3.18 Trip Points

3.18.1 Trip Point Display

This window displays the controller’s trip points. Note

that some trip points are displayed as both%of the rated

or nominal value and as the resulting actual value with

units. Overspeed is displayed in both output Hz and

engine speed in RPM.

3.18.2 Trip Point Setup

Double click anywhere in the trip point data window to

open the setup window.

Use this window to change the controller’s trip point

settings. Type in the LoadShedOutput and Voltage and

Frequency trip points as percentage of the rated or

nominal value. The values entered must be within the

range shown directly to the right of each box. See

Figure 3-25.

When the user enters a number in the text boxes, the

resulting value is displayed in the far right column. For

example, in Figure 3-25, for the over voltage trip point

the user has typed 116% of the nominal voltage. The

application has displayed 556 V for the resulting value.

The resulting values are for reference and not sent to the

controller.

Click on the OK button to enter the new settings and

close thewindow. Clicking onCancel closes thewindow

without changing the settings.

Figure 3-24 Trip Point Display Window

Figure 3-25 Trip Point Setup Window
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Notes
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Section 4 16-Light Generator Set Controllers

4.1 Introduction

Microprocessor-Plus 16-Light Generator Set

Controllers equipped with red main logic boards and the

communications board accessory shown in Figure 4-2

can be used with Monitor III. The controller

communicates at 19200 baud rate.

The communications board is required for Modbus�

communication with this controller. The

communications board is available either

factory-installed or as a field-installed kit. See TT-1377,

provided with the kit, for instructions to install and

connect the board.

#

Figure 4-1 Microprocessor-Plus 16-Light Generator

Set Controller

tp6113

Figure 4-2 Communications Board

4.2 Controller Connection and

Setup

Connect the controller to the PC or network and

configure the controller for communications. Refer to

TT-1405, provided with the Monitor III software kit, for

controller connection and setup information.

4.3 Data Windows

Select Window→NewWindow to open the AddWindow

screen. Select the generator set/controller from the list

on the left. Figure 4-3 illustrates the list of data windows

available for this controller.

The Manual Operations window allows remote starting

and stopping of the generator set and resetting faults.

User or supervisor access is required to performManual

Operations.

There are no setup windows available for this controller.

Figure 4-3 Add Window
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4.4 Data Window Summary Table

Data Window Item Notes

ECM Info Engine Communication Protocol J1939g

MTU

MTU with VSG (variable speed governor)

DC Voltage at ECM Analog-type display. Engine starting battery
voltage as detected at the ECM

ECM Hours of Operation Hours of operation for the engine

ECM Fault Code Engine-specific. Refer to the generator set
controller Operation Manual for the engine
documentation part numbers

Not ECM Equipped Displayed for engines that are not equipped with
engine control modules (ECM)

Engine Info Engine Speed RPM. Analog-type display. Shown for all
engines

Coolant Temperature �C/�F. Analog-type display. Shown for
ECM i d i lFuel Temperature

/ g yp p y
ECM-equipped engines only

Charge Air Temperature

Oil Pressure PSI/kPa. Analog-type display. Shown for
ECM i d i lFuel Pressure

/ g yp p y
ECM-equipped engines only

Charge Air Pressure

Manual
O i

Start Engine Buttons. Read and follow the Safety
P i i h O iOperations Stop Engine

y
Precautions in the generator set Operation
Manual

Reset Faults
Manual.

DIP Switch
S i

Overspeed 60 Hz or 70 Hz overspeed
Settings Temperature Cooldown Enabled/disabled

Crank Mode Continuous/cyclic

Engine Non-ECM, DDC/MTU, J1939 equipped, or MTU
with VSG

Status Controller Application
Program Version Number

Locked Rotor

Run Mode No AC Voltage

Generator Running Speed Sensor Fault

System Ready Intermittent Speed Sensor

Lost ECM Comms Air Damper Switch

Common Fault Low Fuel

High Coolant Temperature High Battery Voltage

Low Coolant Temperature Low Battery Voltage

Low Oil Pressure Battery Charger

Not In Auto ATS Emergency On

Emergency Stop User Input #1

Master Switch Error User Input #2

Overcrank ECM Red Alarm

Overspeed ECM Yellow Alarm
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4.5 DIP Switch Settings

Use this window to view the controller’s DIP switch

settings.

The wording will change to indicate the switch position:

� 50 Hz UNIT/60 Hz OVERSPEED or

60 Hz UNIT/70 Hz OVERSPEED

� TEMP. COOLDOWN ENABLED or

TEMP. COOLDOWN DISABLED

� CONTINUOUS CRANK MODE or

CYCLIC CRANK MODE

� NON-ECM ENGINE,

DDC/MTU ENGINE,

J1939 EQUIPPED ENGINE, or

MTU with VSG ENGINE

Figure 4-4 DIP Switch Settings Window

(display only)

4.6 ECM Info

This window displays engine control module (ECM)

information available to the controller. See Figure 4-5.

ECM fault codes are published in the engine

documentation. To interpret an ECM fault code, refer to

the engine documentation supplied with the generator

set or contact your distributor.

Some generator set models are equipped with engine

ECMs that do not communicate with the generator set

controller over CANbus. The message NOT ECM

EQUIPPED appears if the generator set is not equipped

with an ECM or if the ECM does not communicate with

the generator set controller over CANbus. See

Figure 4-6.

Figure 4-5 ECM Info Display Window

(for engines equipped with ECMs)

Figure 4-6 ECM Info Display Window

(for models without ECMs or CANbus

communication)
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4.7 Engine Info

This window displays available engine information.

For engines not equipped with ECMs, only engine

speed will be shown. See Figure 4-7.

Information available from engines equipped with

engine control modules (ECMs) is displayed as shown

in Figure 4-8.

Figure 4-7 Engine Info (non-ECM engines)

Figure 4-8 Engine Info Window (engines equipped with ECMs)
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4.8 Manual Operations

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote
computer.

This window allows remote starting and stopping of the

generator set. See Figure 4-9. Position the cursor on

the Start Engine or Stop Engine button and click.

Supervisor-level access is required in order to reset

faults remotely using theReset Faults button. Be sure to
identify and correct the cause of any fault.

Figure 4-9 Manual Operations Window
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4.9 Status

The status window displays the overall status of the

controller using red, green, and yellow indicators. See

Figure 4-10. Typically:

� Green indicates systems are functional

� Yellow indicates a warning

� Red indicates a fault or shutdown.

The window also displays the code version of the

controller firmware in the upper right corner.

Lost ECM Comms, ECM Red Alarm, and ECM Yellow

Alarm indications are disabled for generator sets not

equipped with ECMs.

Figure 4-10 Status Window (display only)
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Section 5 Digital Generator Set Controller

5.1 Introduction

Monitor III can be used to monitor system status, view

settings, start or stop the generator set, and reset faults.

#

Figure 5-1 Digital Generator Set Controller

5.2 Controller Connection and

Setup

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator
set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.

(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote
computer.

The Digital controller must be equipped with a KBUS to

Modbus� converter module. Refer to the instructions

provided with the converter module kit to install and

connect the module. Use the DIP switches on the

converter module to assign a unique address to the

controller.

Note: Use a unique address for each device in a

network. Use numbers between 1 and 247.

Do not use 0 (zero).

Connect the controller to the PC or network and

configure the controller for communications. Refer to

TT-1405 for connection diagrams and controller setup

information.

5.3 Data Windows

Select Window→NewWindow to open the AddWindow

screen. Select the generator set/controller from the list

on the left. Figure 5-2 illustrates the list of data windows

available for this controller.

The Manual Operations window allows remote starting

and stopping of the generator set and resetting faults.

User or supervisor access is required to performManual

Operations.

There are no setup windows available for this controller.

Settings can be changed through the controller keypad.

Refer to the controller operationmanual for instructions.

See the List of Related Literature for the document part

number.

Figure 5-2 Add Window Screen
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5.4 Data Window Summary Table

Data Window Item Item Description

Auxiliary Inputs Descriptiony p

Inhibit Time Time in seconds after engine start before time delay begins counting.

Delay Time Time in seconds after initial detection of fault condition before warning or
shutdown occurs.

Common Faults Common Faults 1--6.

See Section 5.6 to interpret fault codes.

Electrical Info Line-to-Line Voltage L1--L2, L2--L3, L3--L1

Line-to-Neutral Voltage L1--L0, L2--L0, L3--L0

Line Current L1, L2, L3

Frequency Actual, Hz

Power Factor

Total kW Actual, kW

Power Level %

History Time Loaded Total and Since Last Maintenancey

TIme Unloaded

Energy Delivered

Days of Operation

Number of Starts

Last Maintenance Date Month/date/year of last maintenance record reset
(reset through controller keypad)

System Start Date Month/date/year

History,
i d

Last Run Start Datey,
continued Start Time

Run Time

Shutdown History Datey

Description (Code)

Manual
O i

Timed Run Engine Run Time, from 1 minute to 72 hours
Operations Set Run Time Button.

Note: Clickingon the set run timebuttonwith anyengine run timeother than

0:00 will cause the engine to start.

Reset Faults Button

RDO RDO1--10 Relay driver outputs.

See Section 5.10 to interpret the displayed codes.

System Info Genset Namey

Location

Description

Model No. Factory-set

Specification No.

y

Genset Serial No.

Controller Serial No.

Device ID

System
S

Switch Positiony
Summary Generator Status

Programming Mode

Genset Rating Factory-set ratings

Nominal Voltage

y g

Nominal Frequency

Nominal Battery Voltage

Status
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Data Window Item DescriptionItem

Time Delays Engine Start Minutes: secondsy

Engine Cooldown

Overvoltage

Undervoltage

Starting Aid

Crank On

Crank Pause

Max. Crank Cycles Number of starting attempts before overcrank shutdown

Trip Points Overvoltage Displayed in % of nominal and in voltsp

Undervoltage

p y

Overfrequency Displayed in % of nominal and in Hz

Underfrequency

p y

Overspeed Displayed in Hz and RPM

High Battery Voltage VDC

Low Battery Voltage

5.5 Auxiliary Inputs

The Auxiliary Inputs window displays the description,

inhibit time, and delay time for each input and indicates

whether the input triggers a warning or a shutdown.

Descriptions are optional and will appear if a description

was previously entered using Monitor II software.

Time delays and inhibit times are set through Menu 4

using the controller keypad. Warnings and shutdowns

are set through Menu 5.
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5.6 Common Faults

The fault codes shown in Figure 5-4 are displayed to

indicate the fault conditions. This information

corresponds to the items displayed in controllerMenu 5.

Each common fault output can indicate up to 8 fault

conditions. The codes for multiple fault conditions are

added together. For example, in Figure 5-3, an

underfrequnecy shutdown (code 8) and an Auxiliary 2

fault (code 128) combine to give a fault code of 136

displayed for Common Fault 1.

Figure 5-3 Common Faults Window

Common
Fault

Fault
Code

Description

1 Air Damper

2 Over Voltage

4 Under Voltage

1
8 Underfrequency Shutdown

1
16 Low Coolant Level

32 High Oil Temperature

64 Auxiliary 1

128 Auxiliary 2

1 Auxiliary 3

2 Auxiliary 4

4 Locked Rotor

2
8 Internal Error

2
16 EPS Supplying

32 Speed Sensor

64 Load Shed

128 kW Overload

1 Underfrequency Warning

2 High Battery Voltage

4 Temp Signal Loss

3
8 Oil Pres Signal Loss

3
16 Ground Fault Detected

32 Over Current

64 TDEC Running

128 TDES Running

1 Generator Running

2 NFPA 110 Common Alarm

4 Starting Aid

4
8 Low Oil Pressure

4
16 High Coolant Temperature

32 Over Crank

64 Over Speed

128 Emergency Stop

1 Not In Auto

2 System Ready

4 Low Battery Voltage

5
8 Battery Charger Fault

5
16 Low Fuel

32 High Coolant Temperature Warning

64 Low Oil Pressure Warning

128 Low Coolant Temperature

1 Weak Battery

2 Load Shed Under Frequency

6 4 Load Shed Excess kW6

8 Low AC Output

16 Over Frequency Shutdown

Figure 5-4 Common Fault Codes
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5.7 Electrical Info

The Electrical Info window displays information about

the power delivered by the generator set. This

information corresponds to the items displayed in

Menu 1 on the controller. See the controller Operation

Manual for more information.

The Power Level is the % Max kW.

Figure 5-5 Electrical Info Window

5.8 History

The History window displays information about the

generator set operaton and the date of the last

maintenance record reset. The items in this window

correspond to the items in controller Menu 2.

Resetmaintenance records using the controller keypad,

Menu 2.

Figure 5-6 History Window
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5.9 Manual Operations

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote
computer.

This window allows remote starting and stopping of the

generator set. It also allows all faults to be reset

remotely.

Enter the desired engine run time, from 1 minute to

72 hours, in hours:minutes. Clicking on the Set Run

Time button starts the engine if the Engine run time

is not zero (00:00). To stop the engine, enter zero

(00:00) in the Engien Run Time box and click on the Set

Run Time button.

Supervisor-level access is require in order to reset faults

remotely using the Reset Faults button. Clicking the

Reset Faults button resets the controller and silences

the alarm. It has the same effect asmomentarilymoving

the generator set master switch to the Off/Reset

position.

The engine start and run time functions are also

accessible using the controller keypad in Menu 7.

Figure 5-7 Manual Operations Window
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5.10 Relay Driver Outputs (RDO)

The Relay Driver Outputs window displays codes that

identify the function assigned to each relay driver

output. For example, the window showed in Figure 5-8

shows that the Underfrequency Shutdown is assigned

to RDO 01. See Figure 5-9 for RDO codes.

RelayOutputs are assigned using the controller keypad,

Menu 5.

Figure 5-8 Relay Driver Outputs Window

Code Message Summary

0 Defined Common Fault

1 Air Damper

2 Over Voltage

3 Under Voltage

4 Under Frequency Shutdown

5 Low Coolant Level

6 High Oil Temperature

7 Auxiliary 1

8 Auxiliary 2

9 Auxiliary 3

10 Auxiliary 4

11 Locked Rotor

12 Internal Error

13 EPS Supplying Load

14 Speed Sensor Fault

15 Load Shed

16 kW Overload

17 Under Frequency Warning

18 High Battery Voltage

19 Coolant Temperature Signal Loss

20 Oil Pressure Signal Loss

21 Ground Fault Detected

22 Over Current

23 Engine Cooldown

24 Time Delay Engine Start

25 Generator Running

Code Message Summary

26 NFPA 110 Common Alarm

27 Starting Aid

28 Low Oil Pressure

29 High Coolant Temperature

30 Overcrank

31 Overspeed

32 Emergency Stop

33 Not In Auto

34 System Ready

35 Low Battery Voltage

36 Battery Charger Fault

37 Low Fuel

38 High Coolant Temperature Warning

39 Low Oil Pressure Warning

40 Low Coolant Temperature

41 Weak Battery

42 Load Shed Underfrequency

43 Load Shed Excess kW

44 Low AC Output

45 Overvoltage L1-L2

46 Overvoltage L2-L3

47 Overvoltage L3-L1

48 Overvoltage L1-L0

49 Overvoltage L2-L0

50 Overvoltage L3-L0

51 Undervoltage L1-L2

52 Undervoltage L2-L3

53 Undervoltage L3-L1

54 Undervoltage L1-L0

55 Undervoltage L2-L0

56 Undervoltage L3-L0

57 Master Switch Open (OFF/RESET)

58 Power-Down Error

59 Overfrequency Shutdown

Figure 5-9 RDO Codes
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5.11 System Info

The system Info window displays the generator set

information shown in Figure 5-10. The Genset Name,

Location, and Load Description are optional and will be

displayed if descriptions were previously entered using

Monitor II software. The model number, specification

number, and serial numbers are factory-set.

Figure 5-10 System Info Window

5.12 System Summary

The System Summary Window is shown in Figure 5-11.

Switch Position indicates the position of the generator

set master switch: Run, Off/Rest, Auto, or Unknown.

Generator Status indicates whether the generator set

engine is cranking, running, or stopped. Programming

mode can be Local, Remote, or Off. See controller

Menu 11.

Generator set rating information corresponds to the

information from Menu 6.

Status indicates the system status.

Figure 5-11 System Summary Window

5.13 Time Delays

The Time Delay window displays the time delays and

maximum number of crank cycles set using the

controller keypad through Menu 4. See Figure 5-12.

Figure 5-12 Time Delay Window

5.14 Trip Points

Trip points are set through Menu 6 using the controller

keypad. Trip points are set as a%of the nominal system

voltage or frequency. The software calulates the

resulting value in Volts or Hz and displays it to the right of

the setting. The overspeed setting is displayed in both

Hz and RPM (engine speed). See Figure 5-13.

Figure 5-13 Trip Points Window
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Section 6 DXPower 1500 ATS Controller

6.1 Introduction

The Monitor III Program allows viewing and adjustment

of selected settings for transfer switches equipped with

the DXPower� 1500 automatic transfer switch

controller. Use the software to:

� View and adjust:

� Source parameters

� Time delays

� Voltage and frequency trip points

� Exerciser settings

� Date and time

� Common alarms

� Audible alarms

� Load control time delays

� Start and stop a system test, exercise, or peak shave

sequence

� Transfer to the OFF position (programmed-transition

models only)

� Assign programmable inputs and outputs

� Toggle Modbus�-controlled relay outputs

� View only:

� System status

� Active time delays

� Current (current sensing accessory required)

� DIP switch settings

� Event history

� Maintenance records

� Input and output status

Be sure to have the transfer switch Operation and

Installation Manual available for reference while using

Monitor III.

6.2 Controller Connection and

Setup

Connect the controller to the PC or network using

RS-485 or Ethernet connections and configure the

controller for communications. Refer to the ATS

Operation and Installation Manual for controller

connection and communications setup instructions.

6.3 Data Windows

The following sections describe data and setup

windows. Select Window>New Window and select an

item from the list to create a data window. See

Figure 6-1.

To open a setup window, first create the associated data

windowand click on it to activate it. Then double-click on

the active data window or choose Window>Setup to

create the setupwindow. Refer to Section 2.10,WIndow

Menu, for more information about creating and working

with setup windows.

A summary table in Section 6.4 lists all of the items

contained in each window, and indicates whether each

item is included in both the display and setup windows.

Use the table as a guide to identify the location of

individual settings, time delays, or other parameters.

Figure 6-1 Add Window Form

Modbus� is a registered trademark of Schneider Electric.
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6.4 Data Window Summary

Window Display Setup Item Notes

Active Time
D l

� Name of active time delay See Section 6.5, Active Time Delay.
Delay � Time remaining, seconds

, y

� Percent time delay elapsed

� Elapsed time graphic display

� End Delay Button ends an active time delay.

Does not end programmed-transition time delays or
an exercise run.

See Section 6.5, Active Time Delay.

Common
Alarms

� Common Alarms, Assigned
Events 1 and 2

Lists events that are assigned as common faults.

� Common Alarms 1 and 2,
Available and Assigned
Events

Use setup to choose common faults from a list of all
available events.

� Audible Alarm Events Lists events that are assigned to the audible alarm.
Alarm module accessory required for audible alarm
horn.

� Audible Alarms, Available and
Assigned Events

Use setup to assign the audible alarm to selected
events or fault conditions.

Date/Time � � Date Does not necessarily match the PC’s date.

Can synch with PC.

Daylight Savings Time feature available.

� � Time Does not necessarily match the PC clock.

Can synch with PC.

� Synchronize with Computer Select button to set time and date to match the PC
system clock.

� Daylight Saving Time Check box to select DST and date boxes to set clock
ahead and back.

DIP Switch
S i

� Password Enabled/Disabled Displays the positions of the controller DIP switches.
Settings � Maintenance/Run Mode

p y p

� Switch 3 position Switches 3 and 4 are not used at this time.

� Switch 4 position

Event History � Lost Preferred Source Displays time, date, and duration of last occurrencey

� Other Events Displays up to 100 events

Clear History Disabled in the Monitor III Program

� Save History Button

Event History
Vi

� Starting Event Allows the operator to view events for a selected time
i d d h fil h

y
View Ending Event

p
period and save them to a file on the computer.

Get Events button

Save History button
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Window NotesItemSetupDisplay

Exerciser
C l d

� Event Number See Section 7.10, Exerciser.
Calendar � � Next Start Date

,

� � Start Time

� � Run Time (hr:min)

� � Loaded (Unloaded)

� � Exercise Interval

� Repeat Rate

Load Control
Time Delays

� � Pre- and Post-transfer Time
Delays

Separate time delays for disconnect before transfer
and reconnect after transfer.

Separate time delays for transfers from Source N to
E and from Source E to N.

Maintenance � Not in Preferred Hours, total and since last reset.

� In Standby

,

� Operation Time Total and since last reset.

� Switch Transfers

� Lost Preferred Source

� Failures to Transfer

� System Start Date Month/Day/Year; factory setting.

� Last Maintenance Reset Date Month/Day/Year.

� Transfer Time N to E Milliseconds (mS); factory setting.

� Transfer Time E to N

( ); y g

� Reset Maintenance Records Resets time since last maintenance to zero.

� System Start Date Distributor-level password required to change.

Manual
Operation

� Peak Shave Start/Stop
Button

Disabled if maintenance DIP switch is set to ON.
p

� System Test: Loaded,
Unloaded, and Auto-Load
Start/Stop Button

Disabled if maintenance DIP switch is set to ON.

� Auto Test Time Duration of auto--load test, 1--60 minutes.

� Programmed Transition
Transfer to Off/Resume
Normal Ops Button

Forces transfer to OFF from Emergency position
only.

Disabled in standard-transition models or if
maintenance DIP switch is set to inhibit transfer

Programmable
I /O

� � Programmable Inputs 1, 2 Main logic board input and output function
i

g
Input/Output � � Programmable Outputs 1, 2

g p p
assignments.

� � I/O Module Address Input/output module input and output function
i� � Inputs 1, 2

p / p p p
assignments.

� � Outputs 1--6 Outputs 1--6 for standard modules, 1--3 for high
power modules.

� Alarm Option Module Displays status of alarm module, if installed.

Remote I/O � Modbus�-Controlled Relay
Outputs

Buttons 1 through 4 to toggle relay outputs on or off.

� Remotely Monitored Inputs Displays status of remotely monitored inputs.

Input/Output
State

� Inputs 1, 2 Displays the status of main logic board and I/O
module inputs and outputs. Indicator is green when
input or output is active.

� Outputs 1--6 Outputs 1--2 for main logic board, 1--6 for standard
modules, and 1--3 for high power modules.
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Window NotesItemSetupDisplay

Setpoints--
F

� � Overfreq Dropout See Section 6.18, Setpoints-Frequency.p
Frequency � � Overfreq Pickup

, p q y

Displays setting in % and resulting frequency in Hz.

� � Underfreq Dropout

p y g % g q y

� � Underfreq Pickup

� � Freq Dropout Time

Setpoints--
V l

� � Overvoltage Dropout See Section 6.19, Setpoints-Voltage.p
Voltage � � Overvoltage Pickup

, p g

Displays setting in % and resulting voltage.

� � Undervoltage Dropout See Section 6.19, Setpoints-Voltage.

� � Undervoltage Pickup

, p g

Displays setting in % and resulting voltage.

� � Voltage Debounce Time

p y g % g g

Site Overview � Address Network address, read from the ATS controller

� Description The ATS description, entered in the Device Form.
See Section 2.5.2.

� Status Displays ATS status. Flashes red to indicate a fault
condition.

� Position Shows the transfer switch position and also uses
colors for quick switch position identification:

Normal position = green
Off position = yellow
Emergency position = red

� Normal Available An X in this column indicates that the Normal source
is available.

� Emergency Available An X in this column indicates that the Emergency
source is available.

Source Info � Voltage A--B Measured voltages, three-phase systems.

� Voltage B--C

g , p y

� Voltage C--A

� Voltage A--N

� Voltage B--N

� Voltage C--N

� Voltage A--C Measured voltage, single-phase systems.

� Frequency Measured frequency.

� Actual Rotation ABC or CBA, three-phase systems.

� Phases Number of phases detected.

� Expected Rotation ABC or CBA, three-phase systems.

� System Voltage Nominal system voltage.

� System Frequency Nominal system frequency.

� Current Amps. Current sensing accessory required.

System
I f i

� � Designation Enter unique descriptions to identify the transfer
i h d l d

y
Information � � Location

q p y
switch and loads.

� � Load Branch

� � Load Description

� � ATS Serial No. * Factory-set. See footnote. *

� � Contactor Serial No. *

y

� � Controller Serial No. � Factory-set. Not adjustable in the field.

� Device ID

y j

� Software Version Nos.

� MAC address

* Distributor-level password is required in order to change these settings. These settings should be changed only if the controller is
replaced in the field.

� Factory set only.
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Window NotesItemSetupDisplay

System
S

� System State See Section 6.22, System Summary.y
Summary � Contactor Position N, E, or OFF (programmed-transition only).

� Preferred Source N or E.

� � Mode of Operation Generator Set to Utility, Utility to Utility, Generator
Set to Generator Set, or Utility-Gen-Gen for 3-source
systems.

� � Util to Gen-Gen Start Mode For 3-source systems only. Preferred first or both
together.

� Preferred Source Toggle For 3-source systems with Start Preferred First
selected.

� � Transition Mode * Open or Programmed-Transition *

� � Rated Current Amps.

� Preferred Source Available Indicator is green when source is available.

� Standby Source Available Indicator is green when source is available.

� Ext. Eng. Time Delay Extended Engine Time Delay: Enabled (requires
external battery supply; see Section 6.22) or
Disabled.

� � Commit to Transfer Enabled or disabled indicator.

� � Peak Shave Delay Bypass Enabled or disabled indicator.

� � Loaded Remote Test Indicator is green if loaded test is enabled.

� � In-Phase Monitor Enabled

[Angle]

Indicator is green if in phase monitor is enabled.

Angle --20 to 20 degrees, leading or lagging.

� � Supervised Transfer Mode � Automatic Override or Non-Automatic. �

� Supervised Transfer Switch
Position

Auto or Manual.

Time Delays � � Source N Engine Start See Section 6.23, Time Delays.y

� � Source E Engine Start

, y

� � Preferred to Standby

� � Standby to Preferred

� � Source N Engine Cooldown

� � Source E Engine Cooldown

� � Fail to Acquire Standby

� � Fail to Acquire Preferred

� � In-Phase Transfer Failure

� � Off to Standby Programmed-transition models only.

� � Off to Preferred

g y

* Distributor-level password is required in order to change these settings. These settings should be changed only if the controller is
replaced in the field.

� Factory set only.
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6.5 Active Time Delay

The Active Time Delay window displays the name of the

time delay that is currently being executed, the amount

of time remaining for that delay, and the percent time

elapsed. The bar shows the progression of the time

delay as it runs. See Figure 6-2.

Figure 6-2 Active Time Delay Display

Supervisor-level access is required in order to use the

End Delay button. Clicking on the End Delay button

ends only the active time delay. Subsequent

programmed time delays will start and run until

completion or until the End Delay button is activated for

each delay.

The End Delay button will not end an exercise or a

programmed-transition (off-to-standby or off-to-preferred)

time delay.

6.6 Common and Audible Alarms

Use the Common Alarms windows to assign and view

the events assigned to the controller’s common alarms

1 and 2 and audible alarm. Any fault condition assigned

to the Common Alarm triggers the Common Alarm

programmable output. See Section 7.15.4,

Programmable Outputs, for more information about

programmable outputs.

Conditions assigned to the audible alarm trigger the

alarm horn. The AlarmModule accessory is required for

audible alarms.

6.6.1 Common Alarms Data Window

This window displays the events that are assigned to the

controller’s common alarm. See Figure 6-3 for an

example of the Common Alarms Display window with a

number of assigned events.

Figure 6-3 Common Alarms Display
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6.6.2 Common and Audible Alarm

Setup Windows

Double click on one of the three display windows shown

in Figure 6-3 to open the corresponding setup window.

The common alarms setup window displays a list of all

events that can be assigned as common alarms. See

Figure 6-4 and Figure 6-5. Select an event from the list

and click on the Add button to assign it as a common or

audible alarm. The event will move from the Available

window to the Assigned window. Use the Remove
button to remove an assigned event.

To assign or remove a block of events, click on the first

event in the list, then hold down theShift key and click on

the last event in the block. To select several individual

events, hold down the control (Ctrl) key while clicking on

each event. Use the Add or Remove key to move all of

the highlighted events.

Refer to the ATS Operation and Installation Manual for

more information about common and audible alarms.

Figure 6-4 Common Alarm Setup

Figure 6-5 Audible Alarm Setup
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6.7 Date/Time Windows

View and set the controller’s time and date settings, or

set the controller’s clock to match the personal

computer’s (PC) clock.

6.7.1 Date/Time Display

The Date/Time display shows the controller’s time and

date settings. See Figure 6-6.

The controller’s settings do not necessarily match those

of the PC. The setup window allows you to synchronize

the ATS clock with the computer clock, if desired.

Figure 6-6 Date/Time Display

6.7.2 Date/Time Setup

Use the drop-down arrow to display a date list and click

on a date from the list to select it, or select Today at the

bottom of the calendar. Another way to enter the date is

to select the date, month, and year one item at a time

and type the current information into the date box. See

Figure 6-7. Click on the OK button or press Enter to

enter the settings. The clock does not reset until OK is

entered.

Use the up and down arrows to set the time or click the

Synchronizewith Computer button to set the controller’s
clock to match the PC’s time.

Figure 6-7 Date/Time Setup

6.7.3 Daylight Saving Time

To set the system to automatically reset the clock for

Daylight Saving Time, click in the Automatically adjust
clock for daylight saving time box so that a check mark

appears. Enter the month, day, and week to set the

clock ahead in the spring and back in the fall.

The clock resets at 2 a.m. If an exercise is scheduled to

begin between 2 and 3 a.m. on the day that the time

changes, that exercise run will be missed.

6.8 DIP Switch Settings

The DIP switch settings window (see Figure 6-8)

displays the positions of the controller’s DIP switches:

� Setup password enabled or disabled

� Maintenance Switch: Maintenance or Run position

� Switches 3 and 4 are not used at this time

Figure 6-8 DIP Switch Settings
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6.9 Event History

The Event History window displays the time, date, and

duration of the last loss of the preferred source. The

window also displays all events in the controller’s event

log, with the time, date, and up to two other parameters

associated with the event. The window displays up to

100 events. See Figure 6-9.

ThemessageEEPROMAccessWarningmay appear in

the event log. If the EEPROM warning message

appears repeatedly, call for service.

Press theSaveHistory button to save the event log in an

ASCII text file. The system allows the user to select the

location to save the file.

Supervisor-level access is required for the Clear History

operation. Pressing theClear History button deletes the
events in the log.

Figure 6-9 Event History Display

6.10 Event History View

The Event History View window allows the operator to

view events for a selected time period and save them to

a file.

Select the starting and ending dates of the desired time

period by clicking on the each Set button and then

selecting a date. The Number of Events parameter on

the screen will change to show the number of events

recorded during that time period.

To save the events to a file, click theSaveHistory button.
A dialogue box opens. Select the location to save the file

and type in a name for the file. Click Save. The file will

be saved with the .log extension.

Figure 6-10 Event History View
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6.11 Exercise Calendar

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.

Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote

computer.

Use the calendar mode to plan up to 21 exercise events

that repeat daily, weekly, or monthly, and choose

whether each event runs with or without load.

6.11.1 Calendar Data Window

The Calendar Data Window (see Figure 6-11) shows

the following plant exerciser information. If an exercise

event is disabled, the line is grayed out.

� Event No.

� Start Date

� Start Time

� Run Time

� Loaded or Unloaded

� Exercise period/Interval

Figure 6-11 Exercise Calendar Display
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6.11.2 Calendar Setup Window

Use the setup window to set up to 21 exerciser run

times, intervals, repeat rates, and loaded/unloaded

condition. See Figure 6-12 for the Calendar Setup

window.

Enabled or Disabled. Click on this box to enable or

disable the exercise event. A check mark in the box

indicates that the event is enabled. An empty box

indicates that the event is disabled and will not run. The

event remains on the calendar so that it can be enabled

again at a later time.

Start Date. There are several ways to select the start

date. Clicking on themonth or year reveals up and down

arrows that allow you to step up or down to the desired

month or year. Selecting the drop-down arrow to right of

the data entry box brings up a calendar. Click on the red

circle at the bottom to select the current day or use the

arrow buttons at the top of the calendar to step to the

desired month and then click on the desired start date.

Start Time. Click on the hour, minute, or AM/PM so that

the desired section is highlighted on the screen. Then

use the arrows to step to the desired hour, minute, or

AM/PM setting or type in the setting from the keyboard.

Run Time. This setting determines the duration of the

exercise run. Run times over 60 minutes will be

automatically converted to hours:minutes. The

maximum run time is 24 hours.

Figure 6-12 Exercise Calendar Setup
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Loaded or Unloaded. A check in the box in the Loaded

column indicates a loaded exercise. If the box is not

checked, the exercisewill start and run the generator set

without transferring the load. Click on the box to select

or deselect it. This setting overrides the loaded/

unloaded DIP switch setting on the main logic board.

Interval. (daily, weekly, monthly, or the same day every

month) This setting overrides the 1 week/2 week DIP

switch setting on the controller’s main logic board. This

setting works with the repeat rate to set the time interval

between exercise runs.

The Day of Month selection allows you to set the

exerciser to run on the same day every month. For

example, the exerciser can be set to run the first Sunday

of every month. Use caution with the Day of Month

selection. For example, selecting Day of Month on the

5th Friday of the month will cause the exerciser to run

only during months that have five Fridays.

Repeat Rate. The repeat rate and interval set the time

interval between exercise runs. For example, if Day is

selected in the interval column, and 5 is entered as the

repeat rate, then the exercise will repeat every 5 days.

Double-click inside the Repeat Rate data box to

highlight the contents, then type in a number between 1

and 12. Attempts to enter a number outside the

acceptable range cause the box to turn red. Values

outside the acceptable range are not accepted by the

program.

6.12 Load Control Time Delays

Use the Load Control Time Delay windows to view and

adjust the time delays for the load control outputs on the

controller’s main logic board and on the optional

input/output modules. Figure 6-13 shows the Load

Control Display window.

Note: The load control function requires the connection

and assignment of load control outputs as well as

setting the load control time delays. Refer to the

ATS Operation and Installation Manual for more

detailed information about the load control

function.

Two time delay settings apply to each load control

output: the load disconnect time before transfer and the

reconnect time after transfer. These time delays allow

selected loads to be disconnected and reconnected in

steps rather than all at once.

See Section 6.16, Programmable Input/Output, to assign

load control outputs to the main logic board and I/O

modules.

6.12.1 Display

The display window shows the pre- and post-transfer

time delay settings in minutes:seconds.

Figure 6-13 Load Control Time Delay Display
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6.12.2 Setup

Use the Setup window to set the duration of each load

control time delay before and after transfer. Enter a time

between 0 seconds and 60 minutes (in

minutes:seconds) into each data entry box. Click OK to

save the settings or Cancel to exit the setup window

without saving the new settings. See Figure 6-14.

Figure 6-14 Load Control Time Delay Setup
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6.13 Maintenance History

6.13.1 Maintenance History Data Window

The Maintenance Display window shows the totals and

the maintenance records since the last maintenance

reset for the items listed in Figure 6-17. Figure 6-15

shows the Display window.

6.13.2 Setup Window

Double click on the Maintenance window to open the

Setup window shown in Figure 6-16. After performing

routine maintenance on the transfer switch, click on the

Reset Maintenance Records button to reset the time

since reset to zero. Click OK.

Use the System Start Date calendar to set the system

start date to the date of the transfer switch installation.

Click onToday at the bottomof the calendar page, or use

the arrow buttons tomove to the desiredmonth and then

click on the date in the calendar. The distributor-level

password is required to set the system start date.

Contact the DDC/MTU Power Generation Power

Systems Service Department to obtain the distributor

password. Type the password into the box and then

click OK.

Figure 6-15 Maintenance Display

Figure 6-16 Reset Maintenance Records
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Historical Data Types

Item Units Description

Time in Operation Minutes Minutes the switch has been under power since leaving the factory

In Standby Minutes Minutes the switch operated in the Emergency position

Hours Not in Preferred Minutes Minutes the switch operated in any position other than the preferred position

Switch Transfers — Number of transfers the switch has completed

Failure to Transfer — The number of time that the contactor failed to transfer when commanded

Lost Preferred Source — Number of times the switch has lost the preferred power source

System Startup Date — The date the system was first started on site

Last Maintenance Reset Date — Date of last maintenance record reset

Transfer time N to E mS Milliseconds (not adjustable)

Transfer time E to N mS Milliseconds (not adjustable)

Figure 6-17 Maintenance Records
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6.14 Manual Operation

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote
computer.

The Manual Operation window (see Figure 6-18)

includes the following items:

� Peak Shave Start/Stop buttons

� System Test Start/Stop buttons

� Unloaded

� Loaded

� Auto-Loaded with Test Time setting

� Programmed-Transition Transfer to OFF button

Note: A user logged on as Guest cannot access the

Manual Operation window.

Manual transfer operations are inhibited if the

Maintenance DIP switch is set to inhibit transfer.

PeakShave. Select theStart button to activate the peak

shave function and initiate peak shave operation. The

ATS starts the standby generator set and transfers the

load to the standby source until the peak shave input is

deactivated through the software. Click on the Stop

button to transfer back to the preferred source and

signal the generator set to stop.

Refer to the transfer switch operation and installation

manual for more information about the Peak Shave

sequence of operation.

Note: A peak shave input signal overrides the software

buttons.

Figure 6-18 Manual Operation

SystemTest. Use the software buttons to start or end a

loaded, unloaded, or auto-loaded test. The Test button
on the controller’s user interface remains functional, so

that a test started by the software can be ended by

pressing the Test button on the user interface, and a test
started by pressing the button on the user interface can

be ended by clicking on the Stop button in the software.

Note: A remote test input signal overrides the software

buttons.

Programmed Transition Transfer to OFF. The

programmed-transition Transfer to OFF button is

disabled if the transfer switch is not a

programmed-transition model. Select the Transfer to
OFF button to force the transfer switch from the

Emergency (Source E) position to the OFF position.

The switch then transfers to Source N if it is available.

The Transfer to OFF button does not function when the

transfer switch is in the normal (Source N) position.

Note: A forced transfer to OFF input signal overrides

the software buttons.

Select the Resume Normal Ops button to end the

Transfer to OFF function. The ATS will transfer to the

preferred source, if available, according to the controller

settings.

Refer to the ATS operation and installation manual for

more information about the Forced Transfer to OFF

(load shed) sequence of operation.
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6.15 Input/Output State

Monitor the status of programmed inputs and outputs on

the logic board and on optional input/output modules

through the Input/Output State window. The indicator is

gray when the input or output is not active and turns

green when the input or output is active.

Figure 6-19 I/O State
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6.16 Programmable Input/Output

View and assign main logic board and programmable

I/O module input and output functions. Refer to the

transfer switch Operation and InstallationManual for I/O

connection instructions and more information on

programmable input and output functions.

Note: Each programmable input and output requires a

connection to the transfer switch. Do not change

the programmable input/output assignments

without verifying the transfer switch input and

output connections.

Note: A user logged on as Guest cannot change the

programmable input/output assignments.

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator
set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.

(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote
computer.

6.16.1 Programmable Input/Output

Display Window

The Programmable Input/Output window shows which

input and output functions are assigned to the controller

main logic board input and output terminals and to the

I/O module input and output terminals.

The I/Omodule address is set by the addressDIP switch

settings on the I/O module. Use the address up and

downarrows to step through the addresses and view the

settings for each I/O module.

Each standard I/O module has 2 programmable inputs

and 6 programmable outputs. High-power modules

have 2 inputs and 3 outputs.

Module Address

Figure 6-20 Programmable Input/Output Display
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6.16.2 I/O Setup Window

Double click in the Programmable Input/Output display

window to open the setup window. Use the

Programmable I/O Setup Window to assign input and

output functions to the main logic board and I/O module

input and output terminals. See Figure 6-21.

Main Logic Board

The main logic board provides 2 programmable inputs

and 2 programmable outputs. Use the Setup window to

assign functions to the controllermain logic board inputs

and output.

Note: Donot change the assignment ofMLB input #1 on

bypass/isolation switches. On bypass/isolation

switches, terminal strip Input #1 is

factory-connected and assigned to the Bypass

Contactor Disable function.

Note: Switches equipped with the load shed accessory

have one input factory-connected and set to

Forced Transfer to OFF. Do not change this

setting.

Module Address

Figure 6-21 Programmable Input/Output Setup

Input/Output Modules

Each standard I/O module provides 2 programmable

inputs and 6 programmable outputs. High-power

modules have 2 inputs and 3 outputs. Monitor III reads

the module type from the controller and allows the

assignment of only 3 outputs for high-power modules.

Note: Be sure to check the address shown in the

address box. See Figure 6-21. The address

resets to 1 each time the setup window is opened

or the OK button is clicked. .

First select the address of the I/Omodule. Then use the

dropdown arrows to select a function for each input or

output. Use the up and down arrows tomove to the next

I/O module and assign functions for that board.

Click on theOK button to accept the I/O assignments or

Cancel to discard the changes.

The same input or output function can be assigned to

multiple locations on either the controller board or any

attached I/O module. Inputs or outputs assigned the

same function will operate together.
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6.17 Remote Input/Output

6.17.1 Display Window

The display window is shown in Figure 6-22.

Software(Modbus)-Controlled Outputs

Software(Modbus)-controlled outputs can be turned on

and off remotely through the remote input/output

window. Click theONbutton to activate the output. Click

the OFF button to turn it off. The indicator next to each

button turns blue when the output is on, and gray when

the output is off.

If a Modbus-controlled output is not assigned to an

output on the main logic board or an I/O module, the

button is not enabled. See Section 6.16 or the transfer

switch Operation/Installation manual to assign inputs

and outputs.

Remotely Monitored Inputs

The status of Remotely Monitored Inputs can be viewed

through this window. Set inputs to user input 1--4

through the Programmable Input/Output window or the

controller’s setup screens. See Section 6.16 or the

transfer switch Operation/Installation manual.

Figure 6-22 Remote Input/Output

6.17.2 Setup Window

The Remote Input/Output Setup window allows the

operator to change the names of the inputs and outputs

that are shown in Monitor III. (The inputs and outputs

displayed on the transfer switch controller’s LCD screen

will not change.)

Figure 6-23 Remote Input/Output Setup Window
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6.18 Setpoints, Frequency

The Frequency Setpoints data window shows the

setpoints in percent of the nominal or the pickup value,

and also shows the resulting setting in Hz. Figure 6-24

shows the frequency setpoints data window with the

factory default settings.

Figure 6-24 Frequency Setpoints Display

(default settings shown)

6.18.1 Display

The datawindow shows the pickup and dropout settings

as percentages of the nominal or pickup frequency as

indicated. The resulting values in Hz are displayed in

the column on the right.

The frequency dropout time is displayed in seconds.

6.18.2 Setup

Note: A user logged on as Guest cannot access the

setup window or change the Frequency

Setpoints.

Open the setup window to change the overfrequency

pickup and dropout settings, the underfrequency pickup

and dropout settings, and the frequency dropout time for

each source. The adjustment range is shown to the right

of each data box. The values shown in Figure 6-25 are

the factory default settings.

Click on the data box to be changed and type in the new

value, in percent of nominal or pickup frequency as

indicated to the right of the box. The resulting frequency

will be displayed in the last column. Click onOK to apply

the new settings or Cancel to discard the changes.

Figure 6-25 Frequency Setpoints Setup

(default settings shown)
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6.19 Setpoints, Voltage

6.19.1 Display

Figure 6-26 shows the voltage setpoints data window

with the factory default settings. The data window

shows the pickup and dropout settings as percentages

of the nominal dropout or pickup voltage as indicated.

The resulting voltages are shown in the column on the

right.

The voltage debounce time is displayed in seconds.

Figure 6-26 Voltage Setpoints Display

(default settings shown)

6.19.2 Setup

Note: A user logged on as Guest cannot access the

setup window or change the Voltage Setpoints.

Open the Setup window to change the overvoltage

pickup and dropout settings, the undervoltage pickup

and dropout settings, and the debounce time for each

source. The adjustment range is shown to the right of

each data box. The values shown in Figure 6-27 are the

factory default settings.

Click on the data box to be changed and type in the new

value, in percent of nominal, pickup, or dropout voltage

as indicated to the right of the box. The resulting voltage

will be displayed in the last column. Click onOK to apply

the new settings or Cancel to discard the changes.

Figure 6-27 Voltage Setpoints Setup

(default settings shown)
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6.20 Source Information

The software provides source voltage, frequency, and

phase information for Source N and Source E.

6.20.1 Display Window

The Source Info data window shows the following

information for each source. See Figure 6-28. Single-

phase systems will display only the single-phase

parameters shown in Figure 6-29.

� Measured voltage

� Measured frequency

� Number of phases

� Expected phase rotation (3-phase only)

� Actual phase rotation (3-phase only)

� Nominal system voltage

� Nominal system frequency

� Line current (current sensing accessory required)

Figure 6-28 Source Info Display, Three-Phase

Source

Figure 6-29 Source Info Display, Single-Phase

Source

6.20.2 Setup Window

Set the nominal voltage and frequency, the number of

phases, and phase rotation for 3-phase sources in this

window. Verify that the settings match the transfer

switch ratings.

Figure 6-30 Source Setup
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6.21 System Information

The System Information window includes load

descriptions, ATS information, and software version

numbers.

6.21.1 System Information Display

See Figure 6-31 for the Source Information Display

window.

000000

000000

000000

Figure 6-31 System Info Display

6.21.2 System Information Setup

Note: A user logged on as Guest cannot access the

setup window or change the system information

settings.

The System Information Setup window (see

Figure 6-32) allows changes to the following

information:

� System designation

� System location

� Load branch

� Load description

Type in unique descriptions to clearly identify the

system, location, and connected loads. Descriptions

are limited to 20 alphanumeric characters, including

spaces.

The serial numbers for the transfer switch, contactor,

and controller are entered at the factory and should not

be changed in the field unless the controller is replaced.

A distributor-level password is required to change the

transfer switch and contactor serial numbers. Change

these serial numbers only if the transfer switch controller

is replaced. Contact the Power Systems Service

Department to obtain the distributor password.

The controller serial number is factory-set and cannot

be changed using the distributor-level password.

Software version numbers are read from the hardware

and cannot be changed with the setup software.

000000

000000

000000

Figure 6-32 System Info Setup
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6.22 System Summary

The System Summary window displays the transfer

switch status. See Figure 6-33.

6.22.1 System Summary Display

System State may indicate System Ready or a fault

condition such as Failure to Acquire Standby. The

controller obtains the system state from the hardware.

For those items with colored status indicators, the

inidcator is blue or green if the associated condition is

active, and gray if the condition is not active.

See the ATSOperation and InstallationManual for more

information about system status messages and

three-source systems.

Figure 6-33 System Summary Display

6.22.2 System Summary Setup

The System Summary Setup window is analogous to

the System Setup menu on the controller.

The Util to Gen-Gen settings are for three-source

systems. See the ATS Operation and Installation

Manual for information about three-source systems.

The transition mode (open or programmed) is

factory-set and should not need to be changed unless

the controller is replaced. Verify that the settingmatches

the contactor type, open (standard) or programmed-

transition. The distributor password is needed to

change the Transition Mode setting. Obtain the

distributor password from the manufacturer’s Power

Systems Service Department.

The Supervised Transfer (non-automatic or automatic

override) setting is factory-set. The setting cannot be

changed in the field.

Figure 6-34 System Summary Setup Window
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6.23 Time Delays

Themonitoring programallows a user to view and adjust

the ATS time delays.

Note: A user logged on as Guest cannot change the

time delay settings.

6.23.1 Time Delay Data Window

The TimeDelayDisplay window displays the settings for

the time delays shown in Figure 6-35.

The Off to Standby and Off to Preferred delays are

displayed only for programmed-transition models.

Note: The settings shown in the figures are not

necessarily the factory default settings. Refer to

the transfer switch Operation/Installation Manual

for default settings.

Figure 6-35 Time Delays Display

6.23.2 Time Delay Setup Window

The Time Delay Setup window (see Figure 6-36) allows

the user to change the ATS delays. The adjustment

range is shown to the right of each data entry box. Refer

to the transfer switch Operation/Installation Manual for

default settings.

Note: A user logged on as Guest cannot access the

setup window or change the time delay settings.

To change the length of a time delay, double-click inside

the data entry box and type in the new setting in

minutes:seconds. Verify that the new setting falls within

the range shown after the data entry box. Values

outside the range will not be accepted. Click on theOK

button or press the Enter key to enter the change.

Note: Extended time delays (longer than 6 seconds)

require the use of an External Battery Supply

Module (EBSM) Kit with a battery. Enable

Extended Engine Start Time Delay in the System

Summary setup window after connecting the

battery to allow longer engine start time delays.

Figure 6-36 Time Delay Setup
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Section 7 DXPower 1000 ATS Controller

7.1 Introduction

The Monitor III Program allows viewing and adjustment

of selected settings for transfer switches equipped with

the DXPower� 1000 automatic transfer switch

controller. Use the software to:

� View and adjust:

� Time delays

� Voltage and frequency trip points

� Exerciser settings

� Date and time

� Common alarms

� Load control time delays

� Start and stop a system test, exercise, or peak shave

sequence

� Transfer to the OFF position (programmed-transition

models only)

� Assign programmable inputs and outputs

� Toggle Modbus�-controlled relay outputs

� View only:

� Source parameters

� System status

� Active time delays

� DIP switch settings

� Event history

� Maintenance records

The view only items listed above can be changed using

the Setup Program running on a PC connected to the

ATS controller’s RS-232 port.

TheMonitor III Programcannot be used to view or adjust

the transfer switch’s communication settings, i.e. the

network address or the network interface baud rate.

Use the Setup Program to view and adjust ATS

communication settings.

Note: Version 1.21 or higher of the ATS controller’s

application software is required for the Monitor III

program to communicate successfully with the

transfer switch. Check the software version

number in the System Information data window;

see Section 7.19.

7.2 Controller Connection and

Setup

Connect the controller to the PC or network and

configure the controller for communications. Refer to

TT-1405, provided with the Monitor III software kit, for

controller connection and setup instructions.

7.3 Data Windows

The following sections describe data and setup

windows. Select Window>New Window and select an

item from the list to create a data window. See

Figure 7-1.

To open a setup window, first create the associated data

windowand click on it to activate it. Then double-click on

the active data window or choose Window>Setup to

create the setupwindow. Refer to Section 2.10,WIndow

Menu, for more information about creating and working

with setup windows.

A summary table in Section 7.4 lists all of the items

contained in each window, and indicates whether each

item is included in both the display and setup windows.

Use the table as a guide to identify the location of

individual settings, time delays, or other parameters.

Figure 7-1 Add Window Form

Modbus� is a registered trademark of Schneider Electric.
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7.4 Data Window Summary

Window Display Setup Item Notes

Active Time
D l

� Name of active time delay See Section 7.5, Active Time Delay
Delay � Time remaining, seconds

, y

� Percent time delay elapsed

� Elapsed time graphic display

� End Delay Button ends an active time delay

Does not end programmed-transition time delays or
an exercise run

See Section 7.5, Active Time Delay

Common
Al

� � Assigned Events Lists events that are assigned as common faults
Alarms � Available Events Use setup to choose common faults from a list of all

available events

Date/Time � � Date Does not necessarily match the PC’s date

Can synch with PC

Daylight Savings Time feature available

� � Time Does not necessarily match the PC clock

Can synch with PC

� System Clock Select button to set time and date to match the PC
system clock

� Daylight Saving Time Check box to select DST and date boxes to set clock
ahead and back

DIP Switch
Settings

� Transfer Inhibited
(Red)/Permitted (Black)

Displays the positions of the controller DIP switches
g

� Loaded/Unloaded Test

� Exercise Inhibited/Permitted

� 1 Week/2 Week Manual
Exercise

� Loaded/Unloaded Exercise

Event History � Lost Preferred Source Displays time, date, and duration of last occurrencey

� Other Events Displays up to 100 events

Clear History Disabled in the Monitor III Program

� Save History Button

Exerciser � � Manual Mode Select exerciser mode

� � Calendar Mode with Override Select button in setup window to enter Calendar
Mode with Override

� � Calendar Mode Select button in setup window to enter Calendar
Mode

� Exercise Inhibited Displays if the Inhibit Exercise DIP switch is activated

� Transfer Inhibited Displays if the Inhibit Transfer DIP switch is activated

� � Next Manual Exercise Start
Date

See Section 7.10

� � Next Manual Exercise Start
Time

� � Manual Exercise Period

� � Manual Exercise
Loaded/Unloaded

DIP switch setting

� � Manual Exercise Run Time Hrs:min.

� Manual Exercise Disable Button

� Push to Set/End Button allows remote start/stop of exercise run
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Window NotesItemSetupDisplay

Exerciser
C l d

� Event Number See Section 7.10, Exerciser
Calendar � � Next Start Date

,

� � Start Time

� � Run Time (hr:min)

� � Loaded (Unloaded)

� � Exercise Interval

� Repeat Rate

Load Control
Time Delays

� � Main Logic Board Load
Control

Separate time delays for disconnect before transfer
and reconnect after transfery

� � I/O Module Load Control
#1--8

Separate time delays for transfers from Source N to
E and from Source E to N

Maintenance � Not in Preferred Hours, total and since last reset

� In Standby

,

� Operation Time Total and since last reset

� Switch Transfers

� Lost Preferred Source

� Failures to Transfer

� System Start Date Month/Day/Year; factory setting

� Last Maintenance Reset Date Month/Day/Year

� Transfer Time N to E Milliseconds (mS); factory setting

� Transfer Time E to N

( ); y g

Manual
Operation

� Peak Shave Start and Stop buttons

Disabled if transfer inhibit DIP switch is set to ON

� System Test Start and Stop buttons

Disabled if transfer inhibit DIP switch is set to ON

� Programmed Transition Transfer to Off and Resume Normal Ops Buttons

Disabled in standard-transition models or if transfer
inhibit DIP switch is set to ON

� Modbus�-Controlled Relay
Outputs

Buttons 1 through 4 to toggle relay outputs on or off

Programmable
I /O

� � Terminal Strip Input #1 Main Logic Boardg
Input/Output � � Terminal Strip Input #2

g

� � Programmable Output

� � I/O Module Address Input/Output Modules

� � Input Event #1

p / p

� � Input Event #2

� � Outputs 1--6

Setpoints--
F

� � Underfreq Dropout See Section 7.16, Setpoints-Frequencyp
Frequency � � Underfreq Pickup

, p q y

� � Overfreq Dropout

� � Overfreq Pickup

� � Freq Dropout Time

Setpoints--
V l

� � Undervoltage Dropout See Section 7.17, Setpoints-Voltagep
Voltage � � Undervoltage Pickup

, p g

� � Overvoltage Dropout

� � Overvoltage Pickup

� � Voltage Debounce Time
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Window NotesItemSetupDisplay

Site Overview � Address Network address, read from the ATS controller

� Description The ATS description, entered in the Device Form.
See Section 2.5.2.

� Status Displays ATS status. Flashes red to indicate a fault
condition.

� Position Shows the transfer switch position and also uses
colors for quick switch position identification:

Normal position = green
Off position = yellow
Emergency position = red

� Normal Available An X in this column indicates that the Normal source
is available

� Emergency Available An X in this column indicates that the Emergency
source is available

Source Info � Voltage A--B Measured voltages, three-phase systems

� Voltage B--C

g , p y

� Voltage C--A

� Voltage A--N

� Voltage B--N

� Voltage C--N

� Voltage L1--L2 Measured voltage, single-phase systems

� Frequency Measured frequency

� Actual Rotation Three-phase systems

� Phases Number of phases detected

� Expected Rotation ABC or CBA

� System Voltage Nominal system voltage

� System Frequency Nominal system frequency

System
I f i

� � Designation Enter unique descriptions to identify the transfer
i h d l d

y
Information � � Location

q p y
switch and loads

� � Load Branch

� � Load Description

� ATS Serial No. Factory-set, not accessible in the field

� Contactor Serial No.

y ,

� Controller Serial No.

� Device ID

� Software Version Nos.
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Window NotesItemSetupDisplay

System
S

� System State See Section 7.20, System Summaryy
Summary � Contactor Position N, E, or OFF (programmed-transition only)

� Preferred Source N or E

� Mode of Operation Generator Set to Utility, Utility to Utility, or Generator
Set to Generator Set

� Transition Mode Open or Programmed-Transition

� Ext. Eng. Time Delay Extended Engine Time Delay: Enabled (requires
external battery supply; see Section 7.20) or
Disabled

� Preferred Source Available Yes= source is available, No = source is not available

� Standby Source Available Yes= source is available, No = source is not available

� Supervised Transfer Mode Automatic Override or Non-Automatic

� Supervised Transfer Switch
Position

Auto or Manual

� Commit to Transfer Enabled or Disabled

� Peak Shave Delay Bypass Enabled or Disabled

� In-Phase Monitor Enabled or Disabled

� In-Phase Monitor Transfer
Angle

--20 to 20 degrees, leading or lagging

� Rated Current Amps

� Number of I/O Modules
Expected

Maximum of 4

Time Delays � � Source N Engine Start See Section 7.21, Time Delaysy

� � Source E Engine Start

, y

� � Preferred to Standby

� � Standby to Preferred

� � Source N Engine Cooldown

� � Source E Engine Cooldown

� � Acquire Standby Source

� � In-Phase Monitor Output

� � Off to Standby Programmed-transition models only

� � Off to Preferred

g y
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7.5 Active Time Delay

The Active Time Delay window displays the name of the

time delay that is currently being executed, the amount

of time remaining for that delay, and the percent time

elapsed. The bar shows the progression of the time

delay as it runs. See Figure 7-2.

Figure 7-2 Active Time Delay Display

Supervisor-level access is required in order to use the

End Delay button. Clicking on the End Delay button

ends only the active time delay. Subsequent

programmed time delays will start and run until

completion or until the End Delay button is activated for

each delay.

The End Delay button will not end an exercise or a

programmed-transition (off-to-standby or off-to-preferred)

time delay.

7.6 Common Alarms

Use the Common Alarms windows to assign and view

the events assigned to the controller’s common alarm.

Any fault condition assigned to the Common Alarm

triggers the Common Alarm programmable output. See

Section 7.15.4, Programmable Outputs, for more

information about programmable outputs.

7.6.1 Common Alarms Data Window

This window displays the events that are assigned to the

controller’s common alarm. See Figure 7-3 for an

example of the Common Alarms Display window with a

number of assigned events.

Figure 7-3 Common Alarms Display

7.6.2 Common Alarm Setup Window

The common alarms setup window displays a list of all

events that can be assigned as common alarms. See

Figure 7-4. Select an event from the list and click on the

Add button to assign it as a common alarm. The event

will move from the Available window to the Assigned

window. Use theRemove button to remove an assigned

event.

To assign or remove a block of events, click on the first

event in the list, then hold down theShift key and click on

the last event in the block. To select several individual

events, hold down the control (Ctrl) key while clicking on

each event. Use the Add or Remove key to move all of

the highlighted events.

Refer to Figure 7-5 for a typical list of events that can be

assigned as common alarms.
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Figure 7-4 Common Alarm Setup

Preferred Source Available Source N Undervoltage

Contactor in Preferred Position Source N Overvoltage

Contactor in Standby Position Source N Loss of Phase

Contactor in Off Position Source N Phase Rotation Error

Contactor in Source N Position Source N Overfrequency

Contactor in Source E Position Source N Underfrequency

Not in Auto Source E Undervoltage

Load Control Active Source E Overvoltage

Exerciser Started Source E Loss of Phase

Test Mode Active Source E Phase Rotation Error

Peak Shave Active Source E Overfrequency

Non-Emergency Transfer Source E Underfrequency

Load Bank Activate Failure to Acquire Standby

In-Phase Monitor Waiting for Synch Failure to Transfer

Modbus-controlled RDO #1 I/O Module Comms Lost

Modbus-controlled RDO #2 I/O Module Not Found

Modbus-controlled RDO #3 I/O Module Not Installed

Modbus-controlled RDO #4 Aux. Switch Fault

System Ready Aux. Switch Open

Source N Available Remote Common Alarm

Source E Available Critical (immediate) Service Required

Low Battery on Standby Source Non-Critical Service Required

Figure 7-5 Typical Common Alarms
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7.7 Date/Time Windows

View and set the controller’s time and date settings, or

set the controller’s clock to match the personal

computer’s (PC) clock.

7.7.1 Date/Time Display

The Date/Time display shows the controller’s time and

date settings. The controller’s settings do not

necessarily match those of the PC. See Figure 7-6.

Figure 7-6 Date/Time Display

7.7.2 Date/Time Setup

Use the drop-down arrow to display a date list and click

on a date from the list to select it, or select Today at the

bottom of the calendar. Another way to enter the date is

to select the date, month, and year one item at a time

and type the current information into the date box. See

Figure 7-7. Click on the OK button or press Enter to

enter the settings. The clock does not reset until OK is

entered.

Use the up and down arrows to set the time or click the

System Clock button to set the controller’s clock to

match the PC’s time.

Figure 7-7 Date/Time Setup

7.7.3 Daylight Saving Time

To set the system to automatically reset the clock for

Daylight Saving Time, click in the box so that a check

mark appears. Enter the dates to set the clock ahead in

the spring and back in the fall. Use the drop-down

arrows to bring up a calendar or type the dates into the

box in the same way as described for setting the current

date.

Note: In succeeding years, the controller will reset the

clock on the day of theweek according to the date

set for the first year. For example, if April 7, 2002

is entered, the clock will reset on the first Sunday

in April, 2003, and succeeding years.

The clock resets at 2 a.m. If an exercise is scheduled to

begin between 2 and 3 a.m. on the day that the time

changes, that exercise run will be missed.

7.8 DIP Switch Settings

The DIP switch settings window (see Figure 7-8)

displays the positions of the controller’s DIP switches:

� Maintenance Switch: Transfer Inhibited (displayed in

red) or Permitted

� Test: Loaded or Unloaded

� Exercise: Inhibited or Permitted

� Manual Exercise: 1 Week or 2 week

� Exercise: Loaded or Unloaded

Figure 7-8 DIP Switch Settings
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7.9 Event History

The Event History window displays the time, date, and

duration of the last loss of the preferred source. The

window also displays all events in the controller’s event

log, with the time, date, and up to two other parameters

associated with the event. The window displays up to

100 events. See Figure 7-9.

ThemessageEEPROMAccessWarningmay appear in

the event log. If the EEPROM warning message

appears repeatedly, call for service.

Press theSaveHistory button to save the event log in an

ASCII text file. The system allows the user to select the

location to save the file.

Supervisor-level access is required for the Clear History

operation. Pressing theClear History button deletes the
events in the log.

Figure 7-9 Event History Display

7.10 Exerciser

View and adjust the plant exerciser settings that are not

directly related to the Calendar mode.

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator
set as follows: (1) Move thegenerator setmaster switch to the

OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote

computer.
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7.10.1 Exerciser Data Window

The plant exerciser data window (see Figure 7-10)

displays the following:

� Exerciser Mode: Manual Mode, Calendar Mode, or

Calendar Mode with Override

� Warnings Window:

� EXERCISE INHIBITED: displays in red if the

Exercise Inhibit DIP switch is set to the ON position

� TRANSFER INHIBITED: displays in red if the

Transfer Inhibit DIP switch is set to the ON position

� Manual Exercise:

� Next Run Date

� Next Run Time

� Period

� Loaded/Unloaded

� Run Time

The period, 1 week or 2 weeks, determines how often

the exerciser runs. The run time shows the duration of

each exercise run. The 1 week/2 week period and

loaded/unloaded exercise are set by DIP switches on

the controller’smain logic board. See the ATS operation

and installation manual for more information about DIP

switches.

Figure 7-10 Exerciser Display

7.10.2 Exerciser Setup Window

Use the plant exerciser setup window (see Figure 7-11)

to set or adjust the following:

� Exerciser Mode: Manual Mode, Calendar Mode, or

Calendar Mode with Override

� Manual Exercise:

� Next Run Date

� Next Run Time

� Period

� Loaded/Unloaded

� Run Time

The Manual Exercise Disable and Set/End buttons

allow control of the manual exerciser through the

software. Selecting the Disable button clears the

manual exercise settings. Clicking on the Push to

Set/End button when the exerciser is in manual mode

has the same effect as pressing the Exercise button on

the ATS user interface, starting or ending an exercise

run.

Use the Calendar Mode or Calendar Mode with

Override buttons in the exercise setup window to enter

the exerciser Calendar mode. Refer to Section 7.11,

Exercise Calendar, for more information about the

Calendar and Calendar with Override modes.

Figure 7-11 Exerciser Setup
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7.11 Exercise Calendar

The calendar provides a method to schedule the

exerciser that is more flexible than using the 1 week/

2 week DIP switch on the transfer switch’s main logic

board. Use the calendar mode to plan up to 21 exercise

events that repeat daily, weekly, or monthly, and choose

whether each event runs with or without load.

Use the Calendar Mode or Calendar Mode with

Override buttons in the Exercise Setup window to enter

the exerciser Calendar modes.

The Calendar Mode and Calendar Mode with Override

settings override the 1 week/2 week and loaded/

unloaded DIP switch settings.

Exercise Button Function in Calendar Modes

� Calendar Mode. In Calendar mode, pressing the

Exercise button does not change the exercise mode

or settings. The Exercise LED flashes quickly for two

seconds if the Exercise button is pressed when the

system is in Calendar Mode.

� Calendar Mode with Override. In Calendar Mode

with Override, pressing and holding the Exercise

button on the ATS user interface until the Exercise

LED flashes overrides and disables the calendar

settings. The calendar settings are saved for future

use, but the exerciser runs inmanual mode until reset

to Calendar Mode or Calendar Mode with Override

through the software.

7.11.1 Calendar Data Window

The Calendar Data Window (see Figure 7-12) shows

the following plant exerciser information. If an exercise

event is disabled, the line is grayed out.

� Event No.

� Start Date

� Start Time

� Run Time

� Loaded or Unloaded

� Exercise period/Interval

7.11.2 Calendar Setup Window

Use the setup window to set up to 21 exerciser run

times, intervals, repeat rates, and loaded/unloaded

condition. See Figure 7-13 for the Calendar Setup

window.

Enabled or Disabled. Clicking on this box so that the

check mark disappears disables that scheduled

exercise event so that it does not run. The event

remains on the calendar so that it can be enabled again

at a later time.

Start Date. There are several ways to select the start

date. Clicking on themonth or year reveals up and down

arrows that allow you to step up or down to the desired

month or year. Selecting the drop-down arrow to right of

the data entry box brings up a calendar. Click on the red

circle at the bottom to select the current day or use the

arrow buttons at the top of the calendar to step to the

desired month and then click on the desired start date.

Start Time. Click on the hour, minute, or AM/PM so that

the desired section is highlighted on the screen. Then

use the arrows to step to the desired hour, minute, or

AM/PM setting or type in the setting from the keyboard.

Run Time. This setting determines the duration of the

exercise run. Run times over 60 minutes will be

automatically converted to hours:minutes. The

maximum run time is 24 hours.

Figure 7-12 Exercise Calendar Display
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Loaded or Unloaded. A check in the box in the Loaded

column indicates a loaded exercise. If the box is not

checked, the exercisewill start and run the generator set

without transferring the load. Click on the box to select

or deselect it. This setting overrides the loaded/

unloaded DIP switch setting on the main logic board.

Interval. (daily, weekly, monthly, or the same day every

month) This setting overrides the 1 week/2 week DIP

switch setting on the controller’s main logic board. This

setting works with the repeat rate to set the time interval

between exercise runs.

The Day of Month selection allows you to set the

exerciser to run on the same day every month. For

example, the exerciser can be set to run the first Sunday

of every month. Use caution with the Day of Month

selection. For example, selecting Day of Month on the

5th Friday of the month will cause the exerciser to run

only during months that have five Fridays.

Repeat Rate. The repeat rate and interval set the time

interval between exercise runs. For example, if Day is

selected in the interval column, and 5 is entered as the

repeat rate, then the exercise will repeat every 5 days.

Double-click inside the Repeat Rate data box to

highlight the contents, then type in a number between 1

and 12. Attempts to enter a number outside the

acceptable range cause the box to turn red. Values

outside the acceptable range are not accepted by the

program.

Figure 7-13 Exercise Calendar Setup
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7.12 Load Control Time Delays

Use the Load Control Time Delay windows to view and

adjust the time delays for the load control outputs on the

controller’s main logic board and on the optional

input/output modules.

Two time delay settings apply to each output: the load

disconnect time before transfer and the reconnect time

after transfer. These time delays allow selected loads to

be disconnected and reconnected in steps rather than

all at once.

Note: Refer to the transfer switchOperation/Installation

Manual for instructions to set up the load control

function. The load control setup also requires

assignment of load control outputs. See

Section 7.15, Programmable Input/ Output, to

assign load control outputs.

7.12.1 Display

Figure 7-14 shows the Load Control Time Delay Display

window.

Figure 7-14 Load Control Time Delay Display
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7.12.2 Load Control Time Delay Setup

Use the Setup window to set the duration of each load

control time delay before and after transfer. Enter a time

between 0 seconds and 60minutes into each data entry

box. See Figure 7-15.

Figure 7-15 Load Control Time Delay Setup
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7.13 Maintenance

7.13.1 Maintenance Data Window

The Maintenance Display window shows the totals and

the maintenance records since the last maintenance

reset for the items listed in Figure 7-17. Figure 7-16

shows the Display window.

Maintenance information cannot be changed or reset

throughMonitor III. Use the ATSSetup program to reset

maintenance records or reload default settings when

necessary.

Figure 7-16 Maintenance Display

Historical Data Types

Item Units Description

Time in Operation Minutes Minutes the switch has been under power since leaving the factory

In Standby Minutes Minutes the switch operated in the Emergency position

Hours Not in Preferred Minutes Minutes the switch operated in any position other than the preferred position

Switch Transfers — Number of transfers the switch has completed

Failure to Transfer — The number of time that the contactor failed to transfer when commanded

Lost Preferred Source — Number of times the switch has lost the preferred power source

System Startup Date — The date the system was first started on site

Last Maintenance Reset Date — Date of last maintenance record reset

Transfer time N to E mS Milliseconds (not adjustable)

Transfer time E to N mS Milliseconds (not adjustable)

Figure 7-17 Maintenance Records

7.14 Manual Operation

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator
set as follows: (1) Move thegenerator setmaster switch to the

OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote

computer.

The Manual Operation window (see Figure 7-18)

includes the following items:

� Peak Shave Start and Stop buttons

� System Test Start and Stop buttons

� Programmed-Transition Transfer to OFF button
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� Modbus� Controlled Relay Outputs

Note: A user logged on as Guest cannot access the

Manual Operation window.

Manual transfer operations are inhibited if the

Maintenance DIP switch is set to inhibit transfer.

PeakShave. Select theStart button to activate the peak
shave function and initiate peak shave operation. The

ATS starts the standby generator set and transfers the

load to the standby source until the peak shave input is

deactivated through the software. Refer to the transfer

switch operation and installation manual for more

information about the Peak Shave sequence of

operation.

Note: A peak shave input signal overrides the software

buttons.

Figure 7-18 Manual Operation

Test. Use the software buttons to start or end a system

test. The Test button on the user interface remains

functional, so that a test started by the software can be

ended by pressing the Test button on the user interface,

and a test started by pressing the button on the user

interface can be ended by clicking on the Stop button in

the software.

Note: A test input signal overrides the software buttons.

Programmed Transition. The programmed-transition

buttons are disabled if the transfer switch is not a

programmed-transition model. Select the Transfer to
OFF button to force the transfer switch from the

Emergency (Source E) position to the OFF position.

The switch then transfers to Source N if it is available.

The Transfer to OFF button does not function when the

transfer switch is in the normal (Source N) position.

Note: A forced transfer to OFF input signal overrides

the software buttons.

Select the Resume Normal Ops button to end the

Transfer to OFF function. The ATS will transfer to the

preferred source, if available, according to the controller

settings.

Refer to the ATS operation and installation manual for

more information about the Forced Transfer to OFF

(load shed) sequence of operation.

Modbus�-Controlled Relay Outputs. The buttons

allow activation of Modbus�-controlled outputs

assigned to the programmable outputs on the Main

Logic Board or I/OModules. The button displaysOutput

OFF when the output is off. Clicking on the button

activates the output. The button displays Output ON.

Click on it again to deactivate the output.

Modbus� is a registered trademark of Schneider Electric.
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7.15 Programmable Input/Output

View and assign main logic board and programmable

(I/O) module input and output functions. Refer to the

transfer switch Operation and InstallationManual for I/O

connection instructions.

Note: Each programmable input and output requires a

connection to the transfer switch. Do not change

the programmable input/output assignments

without verifying the transfer switch input and

output connections.

Note: A user logged on as Guest cannot change the

programmable input/output assignments.

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote
computer.

7.15.1 I/O Data Window

The Programmable Input/Output window shows which

input and output functions are assigned to the controller

main logic board terminal strip input and output

terminals and to the I/O Module input and output

terminals.

Figure 7-19 Programmable Input/Output Display

The I/O module address identifies the I/O board and

must match the address DIP switch settings on the I/O

board.

Bypass/isolation switches have only one programmable

input available for reassignment on the main logic

board. Programmable input 1 is used for a safety

interlock circuit on bypass/isolation switches and is not

available for customer use.
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7.15.2 I/O Setup Window

Use the Programmable I/O Setup Window to assign

input and output functions to the main logic board and

I/Omodule input and output terminals. SeeFigure 7-20.

Figure 7-20 Programmable Input/Output Setup

The main logic board provides 2 programmable inputs

and 1 programmable output. Use the Setup window to

assign functions to the following controller main logic

board inputs and output:

� Terminal strip Input 1 (See note.)

� Terminal strip Input 2

� Programmable output

Note: Terminal strip input 1 is available for

field-connection and assignment on standard

switches only. On bypass/isolation switches,

terminal strip Input 1 is factory-assigned and

connected to the Bypass Contactor Disable

function. Do not change the assignment of MLB

input #1 on bypass/isolation switches!

Each I/Omodule provides 2 programmable inputs and 6

programmable outputs. As many as 4 I/O modules can

be added to the ATS, for total of 10 programmable

inputs (9 for bypass/isolation switches) and 25

programmable outputs. Use the dropdown arrows to

select a function for each input or output. Use the up and

down arrows to move to the next I/O module and assign

functions for that board.

Click on theOK button to accept the I/O assignments or

Cancel to discard the changes.

Note: Be sure to select the address of the I/O module

before assigning I/O module inputs and outputs.

The address resets to 1 each time the OK button

is clicked.

The same input or output function can be assigned to

multiple locations on either the controller board or any

attached I/O module. Inputs or outputs assigned the

same function will operate together.

7.15.3 Programmable Inputs

The available input functions are listed in Figure 7-21

and described in more detail after the table.

Battery Low Fault

Peak Shave

Inhibit Transfer

Remote Bypass

Remote Test

Forced Transfer to OFF

Remote Common Fault

Bypass Contactor Disable
(factory-set for bypass switches only)

Three-Source System Disable

Figure 7-21 Programmable Inputs

Battery Low Fault. Indicates that a low battery signal

(contact closure) has been received from an external

device. The Service Required LED illuminates steadily

and the system records an event in the Event Log.

Peak Shave Active. Starts the generator set and

transfers to the standby source. The systemattempts to

transfer to the preferred source when the input is

removed or the connected source fails. Ignores the

Time Delay Engine Start and standby-to-preferred time

delays if the peak shave delay bypass is selected.

Inhibit Transfer. Prevents all transfers and causes the

Not-in-Auto LED to flash. This input has the same effect

as the Maintenance DIP switch.

Remote Bypass. Functions the same way as the End

TimeDelay button on the user interface, ending any time

delay that is operatingwhen the input is activated except

for the programmed transition off-to-preferred and

off-to-standby time delays. If more than one time delay

is programmed, a separate input signal must be sent to

end each time delay.

Remote Test. Has the same effect as pressing the Test
button on the User Interface. It initiates a system test,

which simulates a preferred source failure and tests the
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transfer switch operation. If a system test is running, this

input will stop the test. To stop tests initiated by this

input, either deactivate the input or press the Test button
on the user interface.

Forced Transfer to OFF Position. (Programmed

transition units only.) Bypasses all time delays and

immediately moves the contactor from Source E to the

OFF position. The ATS will proceed to transfer to

Source N if it is available. When this input is removed,

the system transfers to the preferred source if it is

available. If the preferred source is not available but the

standby source is available, the system transfers to the

standby source.

Remote Common Fault. Any common fault input

causes the Service Required LED to flash.

Bypass Contactor Switch Disable. Disables the

transfer switch on bypass/isolation switches while the

contactor is being inserted or removed. This input is

used only on bypass/isolation switches. It is

factory-assigned to programmable input 1 on the main

logic board (MLB) terminal strip (TB1 terminals 6 and 7).

Do not reassign MLB input 1 on bypass isolation
switches!

Three-Source System Disable. Prevents the second

ATS in a three-source system from starting either

generator set when the Normal source connected to the

first ATS is available. The three-source system disable

output from ATS 1 is connected to the three-source

system disable input on ATS 2. See TT-1340, External

Battery Supply Module Installation Instructions, for

more information about three-source systems.

7.15.4 Programmable Outputs

Programmable monitoring, control, and fault detection

outputs are available through the MLB terminal strip on

the controller or through the programmable input/output

(I/O) modules. The table in Figure 7-22 lists the

available programmable outputs.

Not-in-Auto. Any of the following conditions triggers

the Not-in-Auto output:

� The maintenance switch is activated, preventing

automatic transfer.

� Forced transfer to OFF is activated (programmed-

transition models only).

� The Supervised Transfer Control switch is in the

Manual position (non-automatic switches).

Load Control Active. Any of the following conditions

triggers the Load Control Active output:

� A pre- or post-transfer signal is active.

� Programmable load control outputs are active.

� Peak shave/area protection is engaged.

Load Bank Control. This output allows the application

of a load bank to the generator set during the exercise

period if the exerciser is not set to transfer the actual

load.

The controller deactivates the load bank control and

transfers to the standby source if the preferred source is

lost during an exercise period.

Start SourceNGenerator. Use this engine start output

signal for systems that use a generator set for Source N

(Normal Source). This output is always assigned to the

same generator set regardless of the preferred source

selector switch position.

Peak Shave/Area Protection Active. Indicates that

the system is running on the standby source as a result

of a peak shave command.

Non-Emergency Transfer. Active during peak shave,

loaded exercise, and loaded test sequences.

Synchronization Output Command. Provides a

contact closure after the in-phase monitor synch output

time delay to indicate that the synch output time delay

has expired.

Load Control Outputs. Allows controlled

disconnection of selected loads before transfer and

reconnection in steps after transfer. The Load Control

Time Delays determine the disconnect time before

transfer and reconnect time after transfer. If one source

is lost, the outputs are activated immediately and then

deactivated after the reconnect time delays. Set the

disconnect time before transfer and reconnect time after

transfer through the Load Control Time Delay window.

The times are adjustable from 1 second to 60 minutes.

See Section 7.12, Load Control Time Delays, for

information about setting the load control time delays.

Select up to nine sequential load control outputs, 0--8.

Load control output 0 is always assigned to the main

logic board pre-transfer signal output (TB1 terminals 1

and 2). Outputs 0--8 can be assigned to any position on

an I/O module board or to the programmable output on

the controller board terminal strip. The same function

can be assigned to more than one output.



MP-6347 9/06108 Section 7 DXPower 1000 ATS Controller

Modbus�-Controlled Relay Driver Outputs

(SCRDOs). Use these outputs to transmit signals from

aModbus�master through the ATS controller (acting as

a Modbus slave) to connected equipment. Contact

DDC/MTU Power Generation for Modbus

communications protocol information.

I/O Module Not Found. If the system does not detect

an I/O module at an expected address, the Service

Required LED flashes and the software logs the

message I/O Module Not Found. Check that the

number of I/O modules installed matches the number

expected by the setup program. Check that the I/O

modules are connected and the address DIP switches

are set correctly. Check the diagnostic LED to verify that

the module is receiving power and communicating with

the controller.

I/OModuleNot Installed. If the software detects an I/O

module that is connected but not expected by the setup

program, the Service Required LED flashes and the

software logs the message I/O Module Not Installed.

The system ignores the board if it does not find the setup

definition. Check that the number of I/O modules

expected in the Setup Program matches the number of

modules installed on the transfer switch. Check that the

I/O module address DIP switches are set correctly.

Check the diagnostic LED.

I/O Module Communications Lost. If communication

to an I/O module that was previously installed and

working is lost, the Service Required LED flashes and

the software logs the message I/O Module
Communications Lost. Check the I/O module

connections and diagnostic LED.

Common Alarm. The common alarm output is

activated when any of the fault conditions assigned in

the Common Alarms window occurs. See Section 7.6,

Common Alarms, for more information about assigning

common alarms.

Three-Source System Disable. The three-source

system disable output provides a signal to prevent the

second ATS in a three-source system from starting one

of the generator sets when the Normal source

connected to the first ATS is available. See TT-1340,

External Battery Supply Module Installation

Instructions, for more information about three-source

systems.

Programmable Output Type

Preferred Source Available Monitor

Standby Source Available Monitor

Contactor Preferred Selected Monitor

Contactor Standby Selected Monitor

Contactor in OFF position* Monitor

Contactor Source N Selected Monitor

Contactor Source E Selected Monitor

Not in Auto Monitor

Load Control Active Monitor

Low Backup Battery Indicator Monitor

Exerciser Active Monitor

Test Active Monitor

Peak Shave/Area Protection Active Monitor

Non-Emergency Transfer Monitor

Load Bank Control Control

Start Source N Generator Control

Start Source E Generator Control

Synchronization Output Command Control

Common Alarm Fault

Undervoltage Source N Fault

Overvoltage Source N Fault

Loss of Phase Source N Fault

Phase Rotation Error Source N Fault

Overfrequency Source N Fault

Underfrequency Source N Fault

Undervoltage Source N Fault

Overvoltage Source E Fault

Loss of Phase Source E Fault

Phase Rotation Error Source E Fault

Overfrequency Source E Fault

Underfrequency Source E Fault

Failure to Acquire Standby Source Fault

I/O Module Lost Fault

I/O Module Not Found Fault

I/O Module Not Installed Fault

Failure to Transfer Fault

Auxiliary Switch Fault Fault

Auxiliary Switch Open Fault

Load Shed Control Output Control

Software-Controlled Relay Driver Output #1 � Control

Software-Controlled Relay Driver Output #2 � Control

Software-Controlled Relay Driver Output #3 � Control

Software-Controlled Relay Driver Output #4 � Control

Three-Source System Disable Control

* Programmed-transition switches only
� Abbreviated SCRDO #1--4

Figure 7-22 Available Programmable Outputs

Modbus� is a registered trademark of Schneider Electric.
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7.16 Setpoints, Frequency

The controller senses frequency on both sources with

an accuracy of ±2%. The Frequency Setpoints data

window shows the setpoints in percent of the nominal or

the pickup value, and also shows the resulting setting in

Hz. Figure 7-23 shows the frequency setpoints data

window with the factory default settings.

Figure 7-23 Frequency Setpoints Display

(default settings shown)

A fault occurs if the frequency of either source falls

outside the dropout or pickup settings for a length of time

longer than the frequency dropout time. If the fault

occurs on the active source, the system attempts to

transfer the load to the alternate source.

7.16.1 Display

The datawindow shows the pickup and dropout settings

as percentages of the nominal or pickup frequency as

indicated. The resulting values in Hz are displayed in

the column on the right.

The frequency dropout time is displayed in seconds.

7.16.2 Setup

Note: A user logged on as Guest cannot access the

setup window or change the Frequency

Setpoints.

Open the setup window to change the overfrequency

pickup and dropout settings, the underfrequency pickup

and dropout settings, and the frequency dropout time for

each source. The adjustment range is shown to the right

of each data box. The values shown in Figure 7-24 are

the factory default settings.

Click on the data box to be changed and type in the new

value, in percent of nominal or pickup frequency as

indicated to the right of the box. The resulting frequency

will be displayed in the last column. Click onOK to apply

the new settings or Cancel to discard the changes.

Figure 7-24 Frequency Setpoints Setup

(default settings shown)
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7.17 Setpoints, Voltage

A fault occurs when the voltage of either source falls

outside the dropout or pickup settings for a length of time

longer than the debounce time. If the fault occurs on the

active source, the system attempts to transfer the load

to the alternate source. The debounce time prevents

nuisance transfers caused by brief voltage spikes and

dips.

7.17.1 Display

Figure 7-25 shows the voltage setpoints data window

with the factory default settings. The data window

shows the pickup and dropout settings as percentages

of the nominal dropout or pickup voltage as indicated.

The resulting voltages are shown in the column on the

right.

The voltage debounce time is displayed in seconds.

Figure 7-25 Voltage Setpoints Display

(default settings shown)

7.17.2 Setup

Note: A user logged on as Guest cannot access the

setup window or change the Voltage Setpoints.

Open the Setup window to change the overvoltage

pickup and dropout settings, the undervoltage pickup

and dropout settings, and the debounce time for each

source. The adjustment range is shown to the right of

each data box. The values shown in Figure 7-26 are the

factory default settings.

Click on the data box to be changed and type in the new

value, in percent of nominal, pickup, or dropout voltage

as indicated to the right of the box. The resulting voltage

will be displayed in the last column. Click onOK to apply

the new settings or Cancel to discard the changes.

Figure 7-26 Voltage Setpoints Setup

(default settings shown)
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7.18 Source Information

The software provides source voltage, frequency, and

phase information for Source N and Source E.

The controller senses voltages on all phases of both

sources over a range of 110 to 600 VAC with an

accuracy of ±2%. The controller senses frequency on

both sources with an accuracy of ±2%.

The Source Info data window shows the following

information for each source. See Figure 7-27. Single-

phase systems will display only the single-phase

parameters shown in Figure 7-28.

� Measured voltage

� Measured frequency

� Number of phases

� Expected phase rotation

� Actual phase rotation

� Nominal system voltage

� Nominal system frequency

The Source Info settings cannot be changed through

Monitor III. Use the ATS Setup Program to change

settings, if necessary.

Selected

Figure 7-27 Source Info Display, Three-Phase

Source

Figure 7-28 Source Info Display, Single-Phase

Source
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7.19 System Information

The System Information windows include load

descriptions, ATS information, and software version

numbers.

7.19.1 System Information Display

The Source Information Display window (see

Figure 7-29) lists the following items:

� System designation

� System location

� Load branch

� Load description

� ATS serial number

� ATS contactor serial number

� ATS Controller serial number

� Software version numbers

� I/O module software version numbers

1.21

Figure 7-29 System Info Display

7.19.2 System Information Setup

Note: A user logged on as Guest cannot access the

setup window or change the system information

settings.

The System Information Setup window (see

Figure 7-30) allows changes to the following

information:

� System designation

� System location

� Load branch

� Load description

The serial numbers for the transfer switch, contactor,

and controller are entered at the factory. Software

version numbers are read from the hardware and

cannot be changed with the setup software.

Type in unique descriptions to clearly identify the

system, location, and connected loads. Descriptions

are limited to 20 alphanumeric characters, including

spaces.

Figure 7-30 System Info Setup
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7.20 System Summary

The system summary window displays the transfer

switch status. See Figure 7-31. The ATS Monitor III

software does not allow changes to the parameters

displayed in the System Summary Window. Use the

Setup Program if changes are required.

Figure 7-31 System Summary Display

System State may indicate System Ready or a fault

condition such as Failure to Acquire Standby. The

controller obtains the system state from the hardware.

Figure 7-32 lists some typical System State messages.

System State Message Notes

System Ready Ready, no fault
conditions

Failure to Acquire Standby See the transfer switch
operation and installation

Failure to Transfer
operation and installation
manual.

I/O Module Comms Lost See Section 7.15.4,
P bl O t t

I/O Module Not Found

,
Programmable Outputs.

I/O Module Not Installed

Aux. Switch Fault See the transfer switch
operation and installation

Aux. Switch Open
operation and installation
manual.

Low Battery on Standby
Source

Low battery on the
standby generator set.

Common Alarm See Section 7.6,
Common Alarms.

Figure 7-32 Typical System State Messages
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7.21 Time Delays

Themonitoring programallows a user to view and adjust

the ATS time delays.

Note: A user logged on as Guest cannot change the

time delay settings.

7.21.1 Time Delay Data Window

The TimeDelayDisplay window displays the settings for

the time delays shown in Figure 7-33.

The Off to Standby and Off to Preferred delays are

displayed only for programmed-transition models.

Figure 7-33 Time Delays Display

7.21.2 Time Delay Setup Window

The Time Delay Setup window (see Figure 7-34) allows

the user to change the ATS delays.

Note: A user logged on as Guest cannot access the

setup window or change the time delay settings.

To change the length of a time delay, double-click inside

the data entry box and type in the new setting in

minutes:seconds. Verify that the new setting falls within

the range shown after the data entry box. Values

outside the range will not be accepted. Click on theOK

button or press the Enter key to enter the change.

Note: Extended time delays (longer than 6 seconds)

require the use of an External Battery Supply

Module (EBSM) Kit with a battery. Use the Setup

Program to enable Extended Engine Time Delay

in the System Summary data window after

connecting the battery to allow longer engine

start time delays.

Figure 7-34 Time Delay Setup



MP-6347 9/06 115Section 8 MATS and MATS+ ATS Controllers

Section 8 MATS and MATS+ ATS Controllers

8.1 Introduction

Monitor III can be used to monitor system status, view

settings, and start or stop a remote test. Monitor III

cannot be used to change settings for these controllers.

Refer to the ATS controller Operation Manual for

instructions to change settings using the controller

keypad. See the List of Related Materials for document

part numbers.

8.2 Controller Connection and

Setup

Hazardous voltage.
Will cause severe injury or death.

Disconnect all power sources before
opening the enclosure.

DANGER

Servicing the transfer switch. Hazardous voltage can
cause severe injuryor death. Deenergize all power sources
before servicing. Open themain circuit breakers of all transfer
switch power sources and disable all generator sets as

follows: (1) Move all generator set master controller switches
to the OFF position. (2) Disconnect power to all battery
chargers. (3)Disconnect all battery cables, negative (--) leads
first. Reconnect negative (--) leads lastwhen reconnecting the
battery cables after servicing. Follow these precautions to
prevent the starting of generator sets by an automatic transfer

switch, remote start/stop switch, or engine start command
from a remote computer. Before servicing any components
inside the enclosure: (1) Remove all jewelry. (2) Stand on a
dry, approvedelectrically insulatedmat. (3) Test circuitswitha
voltmeter to verify that they are deenergized.

The controller must be equipped with a Modbus�/KBUS

converter module. Refer to the instructions provided

with the converter module kit to install and connect the

module. Use the DIP switches on the converter module

to assign a unique address to the controller.

Note: Use a unique address for each device in a

network. Use numbers between 1 and 247.

Do not use 0 (zero).

Connect the controller to the PC or network and

configure the controller for communications. Refer to

TT-1405, provided with the Monitor III software kit, for

controller connection and setup instructions.

8.3 Data Windows

Select Window→NewWindow to open the AddWindow

screen. Select the generator set/controller from the list

on the left. Figure 8-1 illustrates the list of data windows

available for this controller.

The Manual Operations window allows remote starting

and stopping of the generator set, resetting faults, and

resetting maintenance records. User or supervisor

access is required to perform Manual Operations.

There are no setup windows available for this controller.

Settings can be changed locally through the controller

keypad. Refer to the controller Operation Manual for

instructions. See the List of Related Literature for

document part numbers.

Figure 8-1 Add Window
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8.4 Data Window Summary Table

The following table lists and describes the items found in each data window. More detailed information for some of the

items is included in the sections after the table.

Data Window Item Item Description

Date/Time Date and time Read from the controller

Frequency
S i

Source N Over Freq Dropout Displays settings in percent of Nominal frequency and in Hz.q y
Setpoints

Source N Over Freq Pickup

p y g p q y

Source N Under Freq Pickup

Source N Under Freq Dropout

Source E Over Freq Dropout

Source E Over Freq Pickup

Source E Under Freq Pickup

Source E Under Freq Dropout

Maintenance
Hi

Time Not in Normal Total hours and hours since last maintenance displayed
History

Time in Emergency

p y

Days of Operation Total and since last maintenance displayed

Number of Transfers

p y

Last Maintenance Date MM/DD/YY

System Start Date

/ /

Exercise: Time Remaining Minutes

Exercise: Last Exercise MM/DD/YY

Last Outage: Date MM/DD/YY

Last Outage: Time HH:MM

Last Outage: Duration Hours

Manual
Operations

Engine Run Time Enter the desired generator set engine run time, in hours:minutes from 1
minute to 72 hours. (00:01 to 72:00)p

Set Run Time Button CLICKING THIS BUTTON STARTS THE GENERATOR SET if the engine
run time displayed is not zero (00:00).

To stop the generator set, set the run time to zero (00:00).

Source Info Source N: Voltage A--B Volts

Source N: Voltage B--C

Source N: Voltage C--A

Source N: Frequency Hz

Source N: System Voltage Volts

Source N: System Frequency Hz

Source E: Voltage A--B Volts

Source E: Voltage B--C

Source E: Voltage C--A

Source E: Frequency Hz

Source E: System Voltage Volts

Source E: System Frequency Hz
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Data Window Item DescriptionItem

System Info ATS Name Description appears if previously assigned with Monitor IIy

Location Description appears if previously assigned with Monitor II

Load Description Description appears if previously assigned with Monitor II

Branch Description appears if previously assigned with Monitor II

ATS Serial Number Factory-set

Controller Serial Number Factory-set

Number of Poles Factory-set

Switch Size Amps, factory-set

System
S

Alert Code See Section 8.11y
Summary

Switch Position Contactor position: Normal, Emergency, or Off

Programming Mode Remote, local, or off

Status messages Normal source availableg

Emergency source available

Test switch in AUTO

Manual transfer mode

Plant exerciser enabled

Load shed enabled

In--phase monitor enabled

Area protection enabled

Ext. time delays enabled

Manual override enabled

Load transfer enabled

Time Delays Engine Start Displayed in minutes:secondsy

Normal to Emergency

p y

Emergency to Normal

Engine Cooldown

Before Emergency

After Emergency

Sequence to Emergency

Return to Emergency

Before Normal

After Normal

Sequence to Normal

Return to Normal

Voltage
S i

Source N: Over Volt Dropout Displays settings in percent of Nominal voltage and in Volts.g
Setpoints

Source N: Over Volt Pickup

p y g p g

Source N: Under Volt Pickup

Source N: Under Volt Dropout

Source E: Over Volt Dropout

Source E: Over Volt Pickup

Source E: Under Volt Pickup

Source E: Under Volt Dropout
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8.5 Date/Time

The program reads the date and time from the controller.

Set the date and time through the controller keypad,

Index 4. See the controller Operation Manual for

instructions.

Figure 8-2 Date/Time Window

8.6 Frequency Setpoints

This data window displays normal and emergency

source pickup and dropout points as percentages of

system frequency and in Hz.

Frequency setpoints can be changed using the

controller keypad through Index 6. See the controller

Operation Manual for instructions.

Figure 8-3 Frequency Setpoints Window

8.7 Maintenance History

Items dispalyed in the maintenance history window

correspond to the information in controller Index 3.

Reset the Since Maintenance records through the

controller keypad. See the controller Operation Manual

for instructions. Total records cannot be reset.

Figure 8-4 Maintenance History Window
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8.8 Manual Operations

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator

set as follows: (1) Move thegenerator setmaster switch to the
OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote

start/stop switch, or engine start command from a remote
computer.

The Manual Operations window allows the operator to

start and run the generator set that is connected to the

ATS engine start contacts. The ATS must have a plant

exerciser accessory installed to access the manual

operations window.

Note: This data menu allows the software operator to

start and run a generator set in a location that is

not within sight of the operator. Use care when

using this feature to prevent unintended starting

of the generator set.

Type the desired engine run time in hours:minutes (from

00:01 to 72:00) in the EngineRun Timebox. Click on the

Set Run Time button to start the generator set.

To stop the engine before the run time expires, type

00:00 in the Engine Run Time box and click on Set Run

Time.

The engine run time returns to 00:00 after the generator

set run time elapses or the generator set stops.

Figure 8-5 Manual Operations Window
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8.9 Source Info

The source data displayed in the Source Information

window correspond to the information in controller

Index 1 and Index 2.

The system voltage and frequency are set using the

controller keypad, Index 6.

Figure 8-6 Source Info Window

8.10 System Info

Descriptions that have been entered using Monitor II

software will be displayed in the System Info window.

Serial numbers, number of poles, and the switch size

are factory-set.

Figure 8-7 System Info Window
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8.11 System Summary

The System Summary window indicates the status of

the transfer switch. See Figure 8-8.

Alert Codes

Alert codes indicate the operating mode of the unit. See

Figure 8-9 for a list of messages that can be displayed.

See the ATS controller operation and installation

manual for more information.

Figure 8-8 System Summary Window

Code Message Summary

Codes 1--18 apply to 3-phase only

0 None

1 PH A-B Normal Overvoltage

2 PH B-C Normal Overvoltage

3 PH A-C Normal Overvoltage

4 PH A-B Normal Undervoltage

5 PH B-C Normal Undervoltage

6 PH A-C Normal Undervoltage

7 Normal Overfrequency

8 Normal Underfrequency

9 Normal Phase Loss

10 PH A-B Emergency Overvoltage

11 PH B-C Emergency Overvoltage

12 PH A-C Emergency Overvoltage

13 PH A-B Emergency Undervoltage

14 PH B-C Emergency Undervoltage

15 PH A-C Emergency Undervoltage

16 Emergency Overfrequency

17 Emergency Underfrequency

18 Emergency Phase Loss

Codes 19--26 apply to 1-phase only

19 Normal Overvoltage

20 Normal Undervoltage

21 Normal Overfrequency

22 Normal Underfrequency

23 Emergency Overvoltage

24 Emergency Undervoltage

25 Emergency Overfrequency

26 Emergency Underfrequency

27 Aux Switch Fault (contactor or controller fault)

28 Dbl Aux Sw Fault (contactor or controller fault)

29 Check Contactor (contactor or controller fault)

30 Power Down Error (controller fault)

31 RAM Error (controller fault)

32 Memory Error (controller fault)

33 Manual Transfer (reset via manual transfer switches)

34 Fault #1 (external fault)

35 Fault #2 (external fault)

Figure 8-9 System Summary Alert Codes
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8.12 Time Delays

Engine start, normal-to-emergency, emergency-to-

normal, and engine cooldown time delays can be

changed using the controller keypad, Index 5.

The rest of the time delays apply to the load shed

settings and are set using the controller keypad,

Index 9.

Figure 8-10 Time Delays

8.13 Voltage Setpoints

This data window displays normal and emergency

source pickup and dropout points as percentages of

system voltage and in volts.

Voltage setpoints can be changed using the controller

keypad, Index 6. See the controller Operation Manual

for instructions.

Figure 8-11 Voltage Setpoints Window
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Section 9 Power Monitor

9.1 Introduction

Monitor III can be used to monitor the Power Monitor

status and to start or stop a remote test.

The Power Monitor must be equipped with a

Modbus�/KBUS converter module. Refer to the

instructions provided with the kit to install and connect

the converter module.

#

Figure 9-1 Digital Power Monitor

9.2 Power Monitor Connection and

Setup

Hazardous voltage.
Will cause severe injury or death.

Disconnect all power sources before
opening the enclosure.

DANGER

Opening the power monitor enclosure. Hazardous
voltage can cause severe injury or death. A transfer switch

or generator set connected to the power monitor could
automatically energize the power monitor or accessories.
Disconnect all power sources before opening the enclosure.
Move the generator set master switch on the controller to the
OFF position and disconnect the battery negative (--) lead
before proceeding.

The power monitor must be equipped with a

Modbus�/KBUS converter module. Refer to the

instructions provided with the converter module kit to

install and connect the module.

Use the DIP switches on the converter module to assign

a unique address to the controller.

Note: Use a unique address for each device in a

network. Use numbers between 1 and 247. Do

not use 0 (zero).

Connect the power monitor to the PC or network and

configure the device for communications. Refer to

TT-1405 for connection diagrams and device setup

instructions.

9.3 Data Windows

Select Window→NewWindow to open the AddWindow

screen. Select the generator set/controller from the list

on the left. Figure 8-1 illustrates the list of data windows

available for this controller.

The Manual Operations window allows remote starting

and stopping of the generator set, resetting faults, and

resetting maintenance records. User or supervisor

access is required to perform Manual Operations.

There are no setup windows available for this controller.

Settings can be changed locally through the controller

keypad. Refer to the controller Operation Manual for

instructions. See the List of Related Literature for

document part numbers.

Figure 9-2 Add Window
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9.4 Data Window Summary

Data Window Item Notes

Analog Inputs Analog Inputs 1 and 2 Displays the measured input in percent of the maximum value, as calibrated
at the power monitor. Refer to the power monitor Operation Manual for more
information.

Auxiliary Inputs Inputs 1--6 Inhibit time in minutes and seconds (mm:ss).y p p

Description, read from the power monitor for each input. Descriptions may
have been changed using Monitor II.

Date/Time Date Read from the power monitor./

Time

p

Electrical Info Voltage, line--line Displays VAC for L1-L2, L2-L3, and L3-L1

Voltage, line--neutral Displays VAC for L1-L0, L2-L0, and L3-L0

Current Displays amps for L1, L2, and L3

Frequency Hz

Total kW Kilowatts

Total kVAR kVAR

Power Factor X.XX

Power Supply Voltage VDC

History Run Time Normal, hoursy

Off, hours

Emergency, hours

Event History Date and event description for the four most recent events

Manual
Operations

Engine Run Time Enter run time in hours:minutes, from 0:00 to 72:00.
To stop the generator set, enter zero (0:00) and then click the Set Run Time
button.

Set Run Time Clicking this button will start the generator set if the Engine Run Time is not
zero (0:00)

System Info Device Name Displays information previously entered using Monitor II software. Cannot be
h d i M i III

y

Location

p y p y g
changed using Monitor III.

Load Description

Model No.

Specification No.

Device Serial No. Displays information read from the Power Monitor. Cannot be changed using
M i III

Controller Serial No.

p y g g
Monitor III.

System Summary System Status See Section 9.12.y y

Contactor Position Normal, Emergency, Off, or Undefined

Programming Mode Local, Off, or Remote

TEST MODE TIMED Grayed out if a test is not running

TEST MODE ACTIVE Grayed out if a test is not running

ATS Rating Read from the power monitor.

Nominal Voltage

p

Nominal Frequency

Phases

Connection Type
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9.5 Analog Inputs

The Analog Inputs window displays the readings for

analog auxiliary inputs 1 and 2. If the descriptions have

been changed using Monitor II software, those

descriptions will be displayed.

The scale of the analog input readings depends on the

power monitor calibration. Refer to the Power Monitor

Operation and Installation manual. See List of Related

Literature.

Figure 9-3 Analog Inputs Window

9.6 Auxiliary Inputs

The time delay information displayed in the Auxiliary

Inputs window corresponds to the user-defined settings

from controller Menu 5.

If the descriptions have been changed using Monitor II

software, those descriptions will be displayed.

Figure 9-4 Auxiliary Inputs Window

9.7 Date/Time

The date and time are read from the power monitor. Set

the time and date at the power monitor through Menu 3.

See the power monitor Operation and Installation

manual.

Figure 9-5 Date/Time Window

9.8 Electrical Info

The system information displayed in the Electrical Info

window corresponds to the information in powermonitor

Menu 1. The information cannot be altered.

Figure 9-6 Electrical Info Window
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9.9 History

The System History window displays 1 to 4 of the last

auxiliary warning or ATS test events, most recent first.

This window corresponds to power monitor Menu 6.

Figure 9-7 History Window

9.10 Manual Operations

Accidental starting.
Can cause severe injury or death.

Disconnect the battery cables before
working on the generator set.

Remove the negative (--) lead first
when disconnecting the battery.
Reconnect the negative (--) lead last
when reconnecting the battery.

WARNING

Disabling the generator set. Accidental starting can
cause severe injury or death. Before working on the
generator set or connected equipment, disable the generator
set as follows: (1) Move thegenerator setmaster switch to the

OFFposition. (2) Disconnect thepower to thebattery charger.
(3) Remove the battery cables, negative (--) lead first.
Reconnect the negative (--) lead last when reconnecting the
battery. Follow these precautions to prevent starting of the
generator set by an automatic transfer switch, remote
start/stop switch, or engine start command from a remote

computer.

The Manual Operations window allows the operator to

start a generator set engine or start an ATS test when

appropriate input and output connections are made to a

generator set or transfer switch. The ATS can start the

generator set and transfer the load during the test if the

ATS is set up to run a loaded test.

Note: This data menu allows the software operator to

start and run a generator set in a location that is

not within sight of the operator. Use care when

using this feature to prevent unintended starting

of the generator set.

Type the desired engine run time in hours:minutes (from

00:01 to 72:00) in the Engine Run Time box. Click on the

Set Run Time button to start the generator set.

To stop the engine before the run time expires, type

00:00 in the Engine Run Time box and click on Set Run

Time.

Figure 9-8 Manual Operations Window
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9.11 System Info

Descriptions and other system information that have

been entered using Monitor II software will be displayed

in the System Info window.

Serial numbers can be entered using the power monitor

keypad through Menu 2. See the Power Monitor

Operation and Installation manual.

Figure 9-9 System Info Window

9.12 System Summary

The System Summary data window displays power

monitor status information.

System Status Messages

Possible system status messages are:

� Test mode active

� System ready

� Power down error

� Auxiliary 1--6. A system warning condition exists

and is caused by auxiliary warning contact input 1--6.

The Test Mode Times and Test Mode Active messages

are grayed out when the power monitor is not running a

test. Starting a test, either through the Manual

Operations screen in this software or through the power

monitor keypad, activates the Test Mode messages.

Figure 9-10 System Summary Window
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Appendix A Abbreviations

The following list contains abbreviations that may appear in this publication.

A, amp ampere

ABDC after bottom dead center

AC alternating current

A/D analog to digital

ADC analog to digital converter

adj. adjust, adjustment

ADV advertising dimensional
drawing

AHWT anticipatory high water
temperature

AISI American Iron and Steel
Institute

ALOP anticipatory low oil pressure

alt. alternator

Al aluminum

ANSI American National Standards
Institute
(formerly American Standards
Association, ASA)

AO anticipatory only

API American Petroleum Institute

approx. approximate, approximately

AR as required, as requested

AS as supplied, as stated, as
suggested

ASE American Society of Engineers

ASME American Society of
Mechanical Engineers

assy. assembly

ASTM American Society for Testing
Materials

ATDC after top dead center

ATS automatic transfer switch

auto. automatic

aux. auxiliary

A/V audiovisual

avg. average

AVR automatic voltage regulator

AWG American Wire Gauge

AWM appliance wiring material

bat. battery

BBDC before bottom dead center

BC battery charger, battery
charging

BCA battery charging alternator

BCI Battery Council International

BDC before dead center

BHP brake horsepower

blk. black (paint color), block
(engine)

blk. htr. block heater

BMEP brake mean effective pressure

bps bits per second

br. brass

BTDC before top dead center

Btu British thermal unit

Btu/min. British thermal units per minute

C Celsius, centigrade

cal. calorie

CARB California Air Resources Board

CB circuit breaker

cc cubic centimeter

CCA cold cranking amps

ccw. counterclockwise

CEC Canadian Electrical Code

cert. certificate, certification, certified

cfh cubic feet per hour

cfm cubic feet per minute

CG center of gravity

CID cubic inch displacement

CL centerline

cm centimeter

CMOS complementary metal oxide
substrate (semiconductor)

cogen. cogeneration

com communications (port)

coml commercial

Coml/Rec Commercial/Recreational

conn. connection

cont. continued

CPVC chlorinated polyvinyl chloride

crit. critical

CRT cathode ray tube

CSA Canadian Standards
Association

CT current transformer

Cu copper

cu. in. cubic inch

cw. clockwise

CWC city water-cooled

cyl. cylinder

D/A digital to analog

DAC digital to analog converter

dB decibel

dBA decibel (A weighted)

DC direct current

DCR direct current resistance

deg., ° degree

dept. department

dia. diameter

DI/EO dual inlet/end outlet

DIN Deutsches Institut fur Normung
e. V.
(also Deutsche Industrie
Normenausschuss)

DIP dual inline package

DPDT double-pole, double-throw

DPST double-pole, single-throw

DS disconnect switch

DVR digital voltage regulator

E, emer. emergency (power source)

EDI electronic data interchange

EFR emergency frequency relay

e.g. for example (exempli gratia)

EG electronic governor

EGSA Electrical Generating Systems
Association

EIA Electronic Industries
Association

EI/EO end inlet/end outlet

EMI electromagnetic interference

emiss. emission

eng. engine

EPA Environmental Protection
Agency

EPS emergency power system

ER emergency relay

ES engineering special,
engineered special

ESD electrostatic discharge

est. estimated

E-Stop emergency stop

etc. et cetera (and so forth)

exh. exhaust

ext. external

F Fahrenheit, female

fglass. fiberglass

FHM flat head machine (screw)

fl. oz. fluid ounce

flex. flexible

freq. frequency

FS full scale

ft. foot, feet

ft. lbs. foot pounds (torque)

ft./min. feet per minute

g gram

ga. gauge (meters, wire size)

gal. gallon

gen. generator

genset generator set

GFI ground fault interrupter

GND, ground

gov. governor

gph gallons per hour

gpm gallons per minute

gr. grade, gross

GRD equipment ground

gr. wt. gross weight

H x W x D height by width by depth

HC hex cap

HCHT high cylinder head temperature

HD heavy duty

HET high exhaust temperature,
high engine temperature

hex hexagon

Hg mercury (element)

HH hex head

HHC hex head cap

HP horsepower

hr. hour

HS heat shrink

hsg. housing

HVAC heating, ventilation, and air
conditioning

HWT high water temperature

Hz hertz (cycles per second)

IC integrated circuit

ID inside diameter, identification

IEC International Electrotechnical
Commission

IEEE Institute of Electrical and
Electronics Engineers

IMS improved motor starting

in. inch

in. H2O inches of water

in. Hg inches of mercury

in. lbs. inch pounds

Inc. incorporated

ind. industrial

int. internal

int./ext. internal/external

I/O input/output

IP iron pipe

ISO International Organization for
Standardization

J joule

JIS Japanese Industry Standard
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k kilo (1000)

K kelvin

kA kiloampere

KB kilobyte (210 bytes)

kg kilogram

kg/cm2 kilograms per square
centimeter

kgm kilogram-meter

kg/m3 kilograms per cubic meter

kHz kilohertz

kJ kilojoule

km kilometer

kOhm, kΩ kilo-ohm

kPa kilopascal

kph kilometers per hour

kV kilovolt

kVA kilovolt ampere

kVAR kilovolt ampere reactive

kW kilowatt

kWh kilowatt-hour

kWm kilowatt mechanical

L liter

LAN local area network

L x W x H length by width by height

lb. pound, pounds

lbm/ft3 pounds mass per cubic feet

LCB line circuit breaker

LCD liquid crystal display

ld. shd. load shed

LED light emitting diode

Lph liters per hour

Lpm liters per minute

LOP low oil pressure

LP liquefied petroleum

LPG liquefied petroleum gas

LS left side

Lwa sound power level, A weighted

LWL low water level

LWT low water temperature

m meter, milli (1/1000)

M mega (106 when used with SI
units), male

m3 cubic meter

m3/min. cubic meters per minute

mA milliampere

man. manual

max. maximum

MB megabyte (220 bytes)

MCM one thousand circular mils

MCCB molded-case circuit breaker

meggar megohmmeter

MHz megahertz

mi. mile

mil one one-thousandth of an inch

min. minimum, minute

misc. miscellaneous

MJ megajoule

mJ millijoule

mm millimeter

mOhm, mΩ
milliohm

MOhm, MΩ
megohm

MOV metal oxide varistor

MPa megapascal

mpg miles per gallon

mph miles per hour

MS military standard

m/sec. meters per second

MTBF mean time between failure

MTBO mean time between overhauls

mtg. mounting

MW megawatt

mW milliwatt

μF microfarad

N, norm. normal (power source)

NA not available, not applicable

nat. gas natural gas

NBS National Bureau of Standards

NC normally closed

NEC National Electrical Code

NEMA National Electrical
Manufacturers Association

NFPA National Fire Protection
Association

Nm newton meter

NO normally open

no., nos. number, numbers

NPS National Pipe, Straight

NPSC National Pipe, Straight-coupling

NPT National Standard taper pipe
thread per general use

NPTF National Pipe, Taper-Fine

NR not required, normal relay

ns nanosecond

OC overcrank

OD outside diameter

OEM original equipment
manufacturer

OF overfrequency

opt. option, optional

OS oversize, overspeed

OSHA Occupational Safety and Health
Administration

OV overvoltage

oz. ounce

p., pp. page, pages

PC personal computer

PCB printed circuit board

pF picofarad

PF power factor

ph., ∅ phase

PHC Phillips head crimptite (screw)

PHH Phillips hex head (screw)

PHM pan head machine (screw)

PLC programmable logic control

PMG permanent-magnet generator

pot potentiometer, potential

ppm parts per million

PROM programmable read-only
memory

psi pounds per square inch

pt. pint

PTC positive temperature coefficient

PTO power takeoff

PVC polyvinyl chloride

qt. quart, quarts

qty. quantity

R replacement (emergency)
power source

rad. radiator, radius

RAM random access memory

RDO relay driver output

ref. reference

rem. remote

Res/Coml Residential/Commercial

RFI radio frequency interference

RH round head

RHM round head machine (screw)

rly. relay

rms root mean square

rnd. round

ROM read only memory

rot. rotate, rotating

rpm revolutions per minute

RS right side

RTV room temperature vulcanization

SAE Society of Automotive
Engineers

scfm standard cubic feet per minute

SCR silicon controlled rectifier

s, sec. second

SI Systeme international d’unites,
International System of Units

SI/EO side in/end out

sil. silencer

SN serial number

SPDT single--pole, double--throw

SPST single--pole, single--throw

spec, specs
specification(s)

sq. square

sq. cm square centimeter

sq. in. square inch

SS stainless steel

std. standard

stl. steel

tach. tachometer

TD time delay

TDC top dead center

TDEC time delay engine cooldown

TDEN time delay emergency to
normal

TDES time delay engine start

TDNE time delay normal to
emergency

TDOE time delay off to emergency

TDON time delay off to normal

temp. temperature

term. terminal

TIF telephone influence factor

TIR total indicator reading

tol. tolerance

turbo. turbocharger

typ. typical (same in multiple
locations)

UF underfrequency

UHF ultrahigh frequency

UL Underwriter’s Laboratories, Inc.

UNC unified coarse thread (was NC)

UNF unified fine thread (was NF)

univ. universal

US undersize, underspeed

UV ultraviolet, undervoltage

V volt

VAC volts alternating current

VAR voltampere reactive

VDC volts direct current

VFD vacuum fluorescent display

VGA video graphics adapter

VHF very high frequency

W watt

WCR withstand and closing rating

w/ with

w/o without

wt. weight

xfmr transformer
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